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Voyetra Multimedia Sound Software
Getting Started
Package Contents

To help you tap the power of the SPEA MEDIA XTC, we've included this package of software tools 
from VoyetraTechnologies, the leader in sound software for the IBM PC and compatibles. The Voyetra
Multimedia Sound Software package will give you many ways to bring the added dimension of sound 
to your computing tasks. 

The Voyetra Multimedia Sound Software in this package is configured to run under Windows on the 
SPEA MEDIA XTC hardware environment, using the ENSONIQ OTTO Wavetable Synthesizer.

Voyetra Multimedia Sound Software
This manual contains all the documentation for:
· Audiostation - An integrated suite of programs that consists of several home stereo-style 

components, or 'modules': Mixer, CD, Digital Audio, and MIDI. Audiostation gives you complete 
control over every aspect of sound on your PC.

· MIDI Orchestrator - The MIDI Orchestrator lets you play, record, and arrange MIDI song files using
a graphical 'mixing console' interface.

· Windows Digital Audio Transport (WinDAT) - A Windows program for recording, editing, and 
playing back digital audio (.WAV) files. WinDAT lets you see your sound as well as hear it, and 
brings the ease of word processing to the task of editing digital audio files.

· Windows Jukebox - Allows you to select sound events from anywhere in your system-MIDI files, 
digital audio files or CD-ROM audio tracks, arrange them into a playlist and play them in the 
order you've arranged.

· Say It! - A Windows utility that lets you easily embed voice notes into any document that supports 
Windows Object Linking and Embedding (OLE).

· A set of Windows drivers that provides the SPEA MEDIA XTC with wavetable synthesis, digital 
audio, MIDI interface, and mixer functionality in the Windows environment. These drivers let you
use the SPEA MEDIA XTC with virtually any Windows application that supports sound.

· DOS Mixer - A utility that lets you control all of the inputs and outputs of the SPEA MEDIA XTC 
from a simple pop-up control panel.

· Command Line File Players - Two utilities, PLAY and DAPLAY, that allow you to play MIDI and 
digital audio files from the DOS command line. These are especially useful for adding sound to 
your batch files.

· Voyetra's Sound Factory drivers for the SPEA MEDIA XTC - These drivers allow you to use the 
SPEA MEDIA XTC with a large number of DOS applications available from Voyetra Technologies 
and many third-party software developers.

Sample Sound and MIDI Files

The Voyetra Multimedia Sound Software package also includes a selection of sound and MIDI files to 
help you get started right away. You'll find details on how to load and use these files in the appropriate
chapters of this manual.

· MusiClips MIDI Song Files - A sampler from the large library of MIDI files available from Voyetra. 
All MusiClips MIDI files are mapped with General MIDI patch assignments for both Base-Level 
and Extended type synthesizers, in compliance with Microsoft's Multimedia Authoring 
Guidelines.

· MusiClips Digital Audio Files - A sampler from Voyetra's library of digital audio files. These files are 
in .WAV format for compatibility with Windows and many DOS applications.
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Before You Begin

Before you start exploring what Voyetra Multimedia Sound Software can do, we urge you to take two 
simple steps: back up the original disk set, most importantly, fill out the Registration Form at the front 
of this book to register your software.

Making Back-Up Disks
Be sure to make back-up copies of the original Voyetra Multimedia Sound Software program disks and
put them away for safe-keeping.

To make back-up copies of the original program disks:
1. Put the original diskette in the A: Drive, type:

DISKCOPY A: [Enter]

2. Follow the onÄscreen instructions.
3. Repeat for each disk in the disk set.

(Substitute 'B:' for 'A:' in the above directions if you are using your B drive).

Registration

Before installing and using the Voyetra Multimedia Sound Software, we urge you to register the 
software with Voyetra Technologies. You can do this by filling out the Registration Form at the front of 
this book and mailing or faxing it to Voyetra. Or you can register by phone.

It is important that you register your software with Voyetra within 10 days of purchase. Only registered
customers may take advantage of the following benefits:

· Limited Warranty
· Update Notifications - We'll keep you informed about software updates and new introductions of 

Voyetra products.
· Upgrade Plan - You will be entitled to discounts on some of Voyetra's full-featured PC sound 

products. For details, see the 'Upgrade Program' section below.
· Voyetracks Newsletter - Includes news about developments at Voyetra Technologies, how your 

colleagues are using Voyetra software, and tips on how you can get the most from Voyetra 
products.

How to Register

Please note that registering the software with Voyetra Technologies is a separate procedure from 
registering your SPEA MEDIA XTC with SPEA V7. In order to receive all the benefits of registered 
ownership, you must do both.

There are three easy ways to register your software with Voyetra. Choose the method that's most 
convenient for you:

By mail...
· Complete the Registration Form at the front of this book and mail it to: Voyetra Technologies, 5 

Odell Plaza, Yonkers, NY 10701-1406.

By Fax...
· Complete the Registration Form at the front of this book and Fax it to us at: (914)-966-1102.

By phone...
· In the US, call Voyetra toll free at: 1-(800)-233-9377Customer technical support is not available at 

this number.
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· Outside the US, call Voyetra at: (914)-966-0600.

We'll ask you for your name and address, the name of your sound hardware product (SPEA 
MEDIA XTC), and its serial number.

Upgrade Program
When you register the Voyetra Multimedia Sound Software package, you'll become eligible to 
participate in Voyetra's software upgrade program: 

· MIDI Orchestrator can be upgraded to an enhanced professional version. 
· WinDAT can be upgraded to Voyetra's top-of-the-line digital audio editor, AudioView, at a 

substantial savings. 
· The MusiClips MIDI files can be upgraded to the Collectors Edition Groups 1, 2 & 3 for a special 

price.

Check the Appendix of this book for details on specific upgrade pricing, policies and additional 
upgrade offers.

From within the USA, call toll-free 1-800-233-9377.
From outside the USA, call (914) 966-0600
You may also FAX Voyetra at (914) 966-1102, or write to:
5 Odell Plaza, Yonkers, NY, 10710-1406

Customer Support

Sooner or later, you may encounter a problem or have a question about the Voyetra Multimedia 
Sound Software. Registered owners may call and a trained technical support person will be glad to 
help you get things straightened out. In return, we ask several things:
1. Please double-check the program documentation before you decide that you need to call for 

technical support. In many cases, this manual will contain the answer to your question.
2. Do some common-sense troubleshooting first to determine whether it is your SPEA MEDIA XTC or

the Voyetra software that is actually the source of the problem. For example, check your SPEA 
MEDIA XTC's hardware setup, audio connections, and MIDI connections.

3. If you find that you need to call for technical support, please have the following information handy: 

· Name of Voyetra software product.
· Software version number.
· Type of sound hardware (SPEA MEDIA XTC).

4. Document the problem as thoroughly as you can, including the steps you took before you 
encountered the problem and any error messages you received. It's also helpful to know certain 
information about your computer setup, such as the computer type and speed (20mHz '386SX, 
etc.), version of DOS and/or Windows you are using, and any other cards or peripherals in your 
system.

Check your SPEA MEDIA XTC hardware manual for the location and phone number of the technical 
support department.
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Software Installation

Before installing the Voyetra Multimedia Sound Software, make sure you've done the following (as per
the instructions in the SPEA MEDIA XTC's hardware documentation):

· Installed the SPEA MEDIA XTC in your PC.
· Installed any additional drivers or utilities that came with the SPEA MEDIA XTC.
· Connected the necessary audio and/or MIDI cables.

Installation Procedure

1. Place the disk labeled 'Voyetra Multimedia Sound Software Disk 1/ Install' into your A: or B: floppy 
drive.

2. Run Windows.
3. From the Windows Program Manager, choose Run from the File menu.

The Run dialog box will appear.
4. From the Run dialog box, enter A:\SETUP (or B:\SETUP) as the Command Line, then click on OK.

5. Follow the on-screen instructions.

The installation program will:
· Create the necessary directories and copy the programs, drivers, and other software into them.
· Create a MEDIAXTC program group with the appropriate icons.
· Install the Windows drivers for the SPEA MEDIA XTC.
· Optionally configure the Windows MIDI Mapper for the SPEA MEDIA XTC.
· Optionally set up the SPEA MEDIA XTC as your CD-ROM controller card.

README File

In some cases there may be additional important information contained in a README file. If there is a 
README file, its icon will be visible in the MEDIAXTC Windows program group.

To read and/or print the README file:

Double click on the README icon.

Windows Write will display the README file.

To print the README file, choose Print from Write's Edit menu.

The Appendix at the end of this book contains additional information on topics like re-installing the 
software, re-configuring the drivers for different hardware settings, compression support, etc.
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Chapter 1
Audiostation

Introduction

Audiostation is an integrated suite of programs that gives you complete control of your PC's sound 
hardware. Because it uses an intuitive 'home stereo component' interface, Audiostation makes it easy 
and fun to work with sound on your PC.

The Modules

Audiostation consists of five main components, called 'modules':

· Power Bar - Launches or closes each of the other modules. When you close a module, it is 
removed from the screen. You also use the Power Bar to quit Audiostation or to activate Help.

· Mixer Module - Controls the SPEA MEDIA XTC's mixer functions when you're using Audiostation 
or other Windows sound programs.
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· CD Module - Plays audio tracks from your CD-ROM drive. The CD Module will only be displayed if
you have a CD-ROM drive properly installed on your system.

· Digital Audio Transport (DAT) Module - Plays and records .WAV and .VOC files using the SPEA
MEDIA XTC's digital audio hardware.

· MIDI Module - Plays and records MIDI files using the SPEA MEDIA XTC's built-in wavetable 
synth, and/or external instruments via the optional MIDI connector.

Starting Audiostation

To start Audiostation:

From the Windows Program Manager, double-click on the Audiostation icon.

Playlists

The DAT, MIDI, and CD Modules each include their own Playlist window for loading digital audio or 
MIDI files and CD audio tracks into Audiostation. As the name implies, you also use the Playlist 
windows to create custom 'playlists' for a particular Audiostation module.

The Playlist windows allow you to locate files or CD audio tracks quickly, arrange the order in which 
they will be played, and save playlists for future sessions. The DAT and MIDI Playlist windows each 
have Audition and Auto Audition buttons, making it easy to preview digital audio or MIDI files before 
adding them to your playlist.

To play a MIDI or digital audio file with Audiostation, you must create a playlist, even if it contains only 
one file.

The Editing Programs:
WinDAT and MIDI Orchestrator

The DAT and MIDI modules each contain an Edit button which allows you to launch a secondary 
program for editing the file currently loaded into that module. When either of these editing programs is 
run, its transport controls will be 'linked' with those of its corresponding Audiostation module.

WinDAT
Pressing the DAT Module's Edit button launches the WinDAT digital audio editor with the current file 
loaded and ready for editing.

MIDI Orchestrator
Pressing the MIDI Module's Edit button launches the MIDI Orchestrator with the current MIDI file 
loaded and ready for editing.
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Playing a Single MIDI or Digital Audio File

To play a single MIDI or digital audio file with one of Audiostation's modules, you must load the file 
from that module's Playlist window. In other words, you must create a playlist, even if it contains only 
one file.

In the next section we'll show you how to create, modify, and save custom playlists containing multiple
files; but for now we're just going to load a single file into the MIDI or DAT module and play it.

The method for loading and playing is essentially the same for both the MIDI and DAT modules; these
instructions apply to both.

To load and play a single file:
1. Click on the Playlist button located on the left side of the desired module: DAT or MIDI.

The corresponding Playlist window will appear.
2. Use the Drive and Directory list boxes to navigate to the drive and directory where the desired file 

is located. If you're going to play a digital audio file, choose the desired file extension, *.WAV or 
*.VOC, from the Type list box.
Any files with the matching extension will now be listed in the Name list box.

3. From the Name list box, double-click on the desired file.
The selected file will now be listed in the Playlist box.

4. Click the OK button to return to the Audiostation module.
5. Play the file by clicking on the module's Play button.

If necessary, you can adjust the playback level by moving the appropriate Mixer Module slider (Synth, 
Wav, or Master).
6. To halt playback before the file is finished, click on the Stop button.

Playing CD Tracks Without a Playlist

You can use the CD Module to play audio tracks from your CD-ROM drive without having to create an 
entire playlist.

To play a CD (without using a playlist):
1. Insert an audio CD in your CD-ROM drive.
2. If necessary, click on the CD Module's Mode button to select Single mode.
3. Click on the Play button.

Click on the Next Track or Previous Track buttons as needed to play the desired track.

If necessary, you can adjust the playback level with the Mixer Module's CD sliders.
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Working with Playlists

One of Audiostation's most useful features is its ability to create and use playlists for digital audio, 
MIDI, and CD audio playback. You simply choose the selections you want to hear, and the 
Audiostation module will play them back in the order you've arranged. As you browse through your 
digital audio or MIDI files, you can audition them to help identify them before you add them to the the 
playlist. Once you've created a playlist, you can save it for later use.

Digital Audio and MIDI Playlists

The DAT and MIDI Playlist windows are almost identical. Since CD audio tracks are not DOS files, the
CD Module's Playlist window operates a little bit differently.

In this section, we'll explain how to use the DAT and MIDI Playlist windows. 

Creating a DAT or MIDI Playlist

Creating a playlist is rather straightforward. On the left side of the Playlist window is an area from 
which you can browse through files or CD tracks. You create your list by adding the desired files or CD
tracks to the Playlist box on the right.

The files or CD tracks you select are always added to the Playlist box directly above the currently-
highlighted line. As items are added, the highlight is always pushed down to the end of the list. Thus, 
you can control the way in which items are added by adjusting the location of the highlight in the 
Playlist box:
· Highlight the appropriate location in the Playlist box before you add an item to it.
· To add an item to the top of the playlist, highlight the first item in the list.
· To add an item to the bottom of the playlist, highlight the blank line below the last item in the list.

Once you've created a playlist, you can switch back to the appropriate Audiostation module to play it 
back.

To create a DAT or MIDI playlist:
1. Click on the Playlist button located on the left side of the DAT or MIDI module.

The appropriate Playlist window will appear. The Playlist box on the right will be blank, and its top 
line will be highlighted.
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2. If you're creating a DAT playlist, choose the desired file extension, *.WAV or *.VOC, from the Type 
list box.
Or, choose *.* to view all the files in a directory.

3. Using the Drive and Directory list boxes, navigate to the drive and directory where the desired file is
located.

Any files in the current directory with the matching extension will be listed in the Name list box.
4. From the Name list box, double-click on any file name to add it to the playlist.
· To add a group of sequential file names to the playlist:  

From the Files list box, click and drag your mouse to highlight the desired file names, then click 
on the Add button.

· To add a group of non-sequential file names to the playlist:  
From the Files list box, hold down the [CTRL] key as you click on the individual file names. 
Once you've highlighted all the desired file names, click on the Add button.

· To add all the matching files in the current directory to the playlist:
Click on the Add All button.Remember that files are always added to the Playlist box directly above
the currently-highlighted line. You control the way in which files are added by highlighting the 
appropriate line.

5. To remove one or more files from the playlist, highlight the desired file name or names in the 
Playlist box using the methods outlined above, then click on the 'Delete' button.

To remove all the files from the playlist, click on the Delete All button.
6. Continue with the above steps as needed to complete your playlist.
7. When your playlist is complete, click the OK button to return to the Audiostation module.
8. To play all the files in your playlist, one after the other, click on the module's Play button.

As each file plays, its name will be displayed in the Current File Indicator.
9.
10.To play the previous or next file in the playlist, click on the Next or Previous button.

To halt playback of the playlist, click on the Stop button.

The playlist will remain active for that module until you close the module, create a different playlist for 
it, or quit Audiostation.
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Auditioning Files from the Playlist

In many cases, you'll want to audition a digital audio or MIDI file to make sure it's the right one before 
adding it to your playlist. You can use one of two different methods to preview files right from the 
Playlist window: use the Audition button if you just need to audition a single file, or enable Auto 
Audition if you want to audition a number of files.

The Audition and Auto Audition features let you preview files from the Name list box, not from the 
Playlist box.

To audition a single digital audio or MIDI file:
1. From the Name list box, highlight the desired file name and click on the Audition button.
2. To halt playback before the file is done playing, click on a different file name or change focus to 

another area, like the Directory list box.

To audition multiple digital audio or MIDI files:
1. Click on the Auto button to enable Auto Audition.The indicator in the upper right corner of the Auto 

button will appear green when Auto Audition is enabled.
2.
3. You can now audition any file simply by clicking on its file name in the Name list box.
4.
5. To halt playback before the file is done playing, click on a different file name or change focus to 

another area, like the Directory list box.
6.
7. To disable Auto Audition, click on the Auto button again.

The indicator in the upper right corner of the Auto button will no longer appear green when Auto 
Audition is disabled.

Saving a DAT or MIDI Playlist

Once you've created a playlist, you can save it to use for future Audiostation sessions.

To save a DAT or MIDI playlist:
1.
2. If necessary, click on the DAT or MIDI Module's Playlist button to access the appropriate Playlist 

window.
3.
4. From the Playlist window, click on the Save button.

The Save Playlist File dialog box will appear.
5.
6. From the Save Playlist File dialog box, navigate to the desired Drive and Directory, and enter a 

valid DOS file name for the playlist.
By default, DAT playlists are saved with a *.VSL file extension; MIDI playlists are saved with a 
*.VML extension.

7.
8. Click on the OK button to save the playlist.
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Loading a DAT or MIDI Playlist File

Once a DAT or MIDI playlist has been saved, you can load and use it with Audiostation at any time.

To load a DAT or MIDI playlist:
1.
2. If necessary, click on the DAT or MIDI Module's Playlist button to access the appropriate Playlist 

window.
3.
4. From the Playlist window, click on the Load button.

The Load Playlist File dialog box will appear.
5.
6. From the Load Playlist File dialog box, navigate to the desired Drive and Directory.
7.
8. Double-click on the desired playlist file name.

Or, click on the desired file name and click on the OK button.

The CD Playlist

For the most part, the CD Playlist window operates in the same way as the DAT and MIDI Playlist 
windows. To create a CD playlist, you select tracks from the CD Tracks list box and place them in the 
Playlist box, just as you do with digital audio and MIDI files.

However, because the CD audio tracks are not DOS files, there are several differences:

· A CD Tracks list box is displayed on the left side of the CD Playlist window.
· Above each list box (CD Tracks and Playlist) is a display showing the Total Tracks and the Total 

Time in each list.
· The Add All button lets you add all the tracks on the CD to the playlist with a single mouse click.
· The Name CD and Name Track buttons appear in place of the Audition and Auto buttons.
· There are no Load and Save buttons.

When you first load a new CD, the CD Tracks list box will merely display Untitled 1, Untitled 2, and so 
on, for each track on the disk. The CD Playlist window lets you replace these labels with the actual 
titles of the tracks (or any other text), and also lets you assign a name to the CD itself.
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Unlike the DAT and MIDI playlists, you don't have to actually 'save' a CD playlist. Instead, whenever 
you click on the OK button from the CD Playlist window, the CD Module will automatically 'remember' 
the CD Name, Track Names, and the playlist order for that particular disk. Whenever you 
subsequently load that disk, the Playlist window will display the information you last associated with it. 
Like the DAT and MIDI playlists, you can edit a CD playlist any time you wish. However, you cannot 
save multiple playlists for the same CD.
Naming a CD and its tracks are optional; you can still create and save a playlist for a particular CD 
even if you don't name the disk or its tracks.

To name a CD:
1.
2. From the CD Playlist window, click on the Name CD button.

The Name CD dialog box will appear.
3.
4. From the Name CD dialog box, enter the desired title for the disk.
5.
6. Click on the OK button.

The name you entered will now appear in the title bar of the CD Playlist window.

To name CD tracks:
1.
2. Click on the desired track in the CD Tracks window.
3.
4. Click on the Name Track button.

The Name Track dialog box will appear.
5.
6. From the Name Track dialog box, enter the desired name for the track.
7.
8. To name the next track, press the [Enter] key or click on the Next button Then enter the name 

using the method described above.
You can also click on the Up or Down arrows to access the next or previous track.

9.
10.When you've finished naming tracks, click on the OK button.

The new track names will be displayed in the CD Tracks list box.
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Playlist Window Buttons

Add
Adds the highlighted file(s) or CD track(s) to the playlist.

Add All
Adds all the files currently listed in the Name list box (or all the tracks listed in the CD Tracks list box) 
to the playlist.

Delete
Removes the highlighted file(s) or CD track(s) from the playlist.

Delete All
Removes all files or CD tracks from the playlist.

Audition
Plays the file that is currently highlighted in the Files list box.(DAT and MIDI only)
Auto
When Auto is enabled, files automatically play when highlighted in the Files list box. (DAT and MIDI 
only)

OK
Closes the Playlist window and returns to the appropriate Audiostation module with the playlist loaded.

Close
Closes the Playlist window and returns to the appropriate Audiostation module without updating the 
playlist.

Save
Activates a dialog box from which you can save the playlist as a file.(DAT and MIDI only)

Load
Activates a dialog box from which you can load an existing playlist file.(DAT and MIDI only)

Name CD
Activates a dialog box from which you can enter a title for the CD.(CD only)

Name track
Activates a dialog box from which you can enter titles for each track on the CD.(CD only)
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The Audiostation Modules

The Power Bar Module

The Power Bar Module has several functions. It lets you:
· Open or close any of the other Audiostation modules.
· Determine the arrangement in which the modules are displayed.
· Access Audiostation's on-line Help system.
· Quit Audiostation.

To open or close a module:
1.
2. Click on the appropriate icon button on the Power Bar.
3.
4. Once a module is open, you can click on its icon again in the Power Bar to close it.

When you open a module, it will always be inserted below the modules that are currently open. Thus, 
you can control the arrangement of Audiostation's modules simply by varying the order in which you 
open them. The current module arrangement is saved whenever you quit Audiostation.

To arrange the Audiostation modules:
1.
2. From the Power Bar, close all open modules by clicking on their icons.
3.
4. Arrange the modules by clicking on their icons in the order in which you want them to appear, from 

top to bottom.

To quit Audiostation:

From the Power Bar, click on the Power button.

To access Audiostation's on-line Help:

From the Power Bar, click on the Help (?) button.
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The Mixer Module

The Mixer Module provides an easy-to-use graphical interface to control the SPEA MEDIA XTC's 
various mixer functions. You can use the Mixer Module to control the SPEA MEDIA XTC's mixer 
functions when you're using Audiostation or most other Windows sound programs.

Mixer Controls

Power
Closes the Mixer Module.

Lock
Locks all pairs of stereo sliders together, allowing you to control both the left and right levels 
simultaneously.To set a pair of locked sliders to equal levels, drag both sliders all the way to the top or
bottom.

Default
Sets all of the Mixer Module's controls to a combination of useful default settings.

Synth
A single mono slider to control the playback level of the SPEA MEDIA XTC's on-board wavetable 
synthesizer.

Wav
A single mono slider to control the playback level of the SPEA MEDIA XTC's digital audio hardware.

CD/Aux
A pair of stereo sliders to control the playback level of either a line-level audio device connected to the
SPEA MEDIA XTC's Line In jack, or your CD-ROM drive's audio output.

To control the CD-ROM drive's audio output with the Line sliders, it must be connected to either the 
Line In jack or the multi-pin header located on the SPEA MEDIA XTC's PC board.

This feature lets you blend external auxiliary devices with the rest of the SPEA MEDIA XTC's sound 
sources.

Mic/Line
A pair of stereo sliders to control the playback level of a microphone or line-level device connected to 
the SPEA MEDIA XTC's Mic/Line jack. Use the button to the right of the sliders to select Microphone 
or Line.

This feature lets you blend narration or vocals with the rest of the SPEA MEDIA XTC's sound sources.
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Record
These controls let you choose the record source (Mic, CD/Aux, or All) and set its level with a pair of 
stereo sliders.These buttons are mutually exclusive; i.e.: you can only enable one record source at a 
time.

Choosing All lets you record a blend of all the SPEA MEDIA XTC's audio sources, including the on-
board wavetable synthesizer.

Master
A single mono slider to control the SPEA MEDIA XTC's overall playback level.

The CD Module

The CD module lets you play standard audio CD's from your CD-ROM drive. It resembles a home CD 
player, with familiar transport controls.

You cannot access the CD Module unless you have a CD-ROM drive installed and properly configured
with its device driver and the Microsoft CD-ROM Extensions (MSCDEX). If the CD Module does not 
appear when you run Audiostation or click on the CD Module button, your CD-ROM drive and/or its 
drivers may not be installed correctly. Refer to the drive's documentation for information on how to 
install and configure it.

Buttons

Power
Closes the CD Module.

Audiostation (and most other CD applications) periodically 'polls' the CD-ROM drive, which can 
sometimes tax your system resources. Therefore, it is recommended that you close the CD Module 
when you're not using it, especially when you're recording digital audio at high data rates.

Eject
Ejects the CD from your CD-ROM drive.

This button will have no effect if your CD-ROM drives has a manual (non-motorized) eject mechanism.

Playlist
Activates the CD Module's Playlist window.

Mode
Determines the CD Module's playback mode. The current mode is displayed at the far right of the 
Display area. The available playback modes are:

· Playlist - Sequentially plays each track in the playlist once through and stops after the last track.
· Shuffle - Continuously plays the tracks in the playlist in random order.
· Loop - Sequentially plays each track in the playlist and repeats the list from the top when 

completed.
· Single - Plays all the tracks on the CD once through and stops after the last track, disregarding the

playlist. 
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Transport Controls

The CD Module's transport controls are modeled after those found on a standard home CD player. 
The controls are: Play, Stop, Pause, Rewind, Fast Forward, Previous, and Next.

Previous
Lets you move to the previous track in the playlist.

[Shift]-click on the Previous button to move to the first track in the playlist.

Next
Lets you move to the next track in the playlist.

[Shift]-click on the Next button to move to the last track in the playlist.

Display

TrackNumber
Displays the number of the current track, relative to its position in the playlist.

Play/Pause indicators
These indicators light up when the CD Module is in Play or Pause mode.

Min:Sec
Displays the amount of elapsed time from the beginning of the current track.

Digital Audio Transport ( DAT ) Module

The Digital Audio Transport (DAT) Module allows you to play and record digital audio files in the .WAV
or .VOC file formats. Like the other Audiostation modules, it features a 'home stereo component' 
interface withfamiliar transport controls, and lets you access a playlist for playing groups of digital 
audio files. From the DAT Module, you can also launch a full-featured digital audio editor called 
WinDAT.

Using the DAT Module

When you click on the Play button, the DAT Module will play the files in the playlist sequentially. You 
can use the Next File and Previous File buttons to scroll through the playlist. The current file name is 
displayed in a window above the cassette tape, and its file number in the playlist is displayed in the 
Track window.

When playing or recording a file with the DAT Module:
· An animated tape movement is displayed to indicate transport activity.
· The VU Meters show the record or playback level.
· The elapsed time of the file is displayed by the MIN:SEC indicators.

To play one or more digital audio files:
1.
2. From the DAT module, create a playlist as previously instructed.

To play a single file, create a playlist containing one file.
3.
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4. From the Playlist window, click on the OK button to return to the DAT Module with the playlist 
loaded.

5.
6. Click on the DAT Module's Play button.
7.
8. You can move to a specific file in the playlist by clicking on the Next and Previous buttons.
If necessary, you can adjust the playback level with the Mixer Module's WAV sliders.

To record a digital audio file:
1.
2. If necessary, use the Mixer Module to select the input source and set its record level.
3.
4. Click on the DAT Module's Record button.

The red LED will blink, indicating that the DAT module is in Record Standby mode.
5.
6. To begin recording, click on the Play button.

While recording, the VU Meters will display the record level. If the red LED's light up most of the
time, you may need to use the Mixer Module to reduce the record levels.

7.
8. When you're finished recording, click on the Stop button.

If you want, click on the Play button to hear what you've just recorded.
9.
10.When you're satisfied, click on the Edit button to access WinDAT and save the file.

If you have a playlist loaded, the new file will be inserted as the last file in the playlist.

When you record, the DAT Module will use the current Record parameters from WinDAT's Setup 
window (sample rate, bit resolution, mono/stereo, etc.). For more information on the Setup window, 
refer to the WinDAT chapter.

To edit a file from the DAT Module:
1.
2. Load a single file or a playlist into the DAT Module.

If you've loaded a multi-file playlist, use the Next File/Previous File buttons to access the 
desired file.

3.
4. From the DAT Module, click on the Edit button to activate WinDAT.
5.
6. Edit the file as necessary with WinDAT.

Editing digital audio files is described in detail in the WinDAT chapter.
7.
8. From WinDAT, save the edited file with either the same name or a new name, as desired.

Buttons

Power
Closes the DAT Module.

Edit
Launches WinDAT with the current file loaded. You access WinDAT to edit the current digital audio 
file, set the Record parameters for the DAT Module, or save a file you've recorded with the DAT 
Module.

Playlist
Activates the DAT Module's Playlist window.
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Transport Controls

The transport controls are modeled after those found on a standard home tape deck. The controls are:
Play, Record, Stop, Pause, Rewind, Fast Forward, Previous, and Next.

Previous
Lets you move to the previous file in the playlist.

[Shift]-click on the Previous button to move to the first file in the playlist.

Next
Lets you move to the next file in the playlist.

[Shift]-click on the Next button to move to the last file in the playlist.
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Display

Current File Indicator
The name of the current digital audio file appears in the area above the cassette tape graphic.

Track
Shows the number of the current digital audio file, relative to its position in the playlist.

Min:Sec
Displays the amount of elapsed time from the beginning of the current digital audio file.

Play/Pause Indicators
These indicators light up when the DAT Module is in Play or Pause mode.

VU Meters
These bar-graph meters display the digital audio playback or record levels in real time.

For stereo files, separate left and right levels are displayed. For mono files, both meters display 
identical levels.

The DAT Module will even let you record the audio output from the SPEA MEDIA XTC's wavetable 
synthesizer or your CD-ROM drive, as controlled by the MIDI or CD Modules. This allows you to make
digital recordings off of a CD, or make digital recordings of your MIDI files.

To record the output of the CD or wavetable synth:
1.
2. Use the Mixer Module to select either Synth or CD as the record source, and adjust the record 

level to a reasonable value.

To record the output of the CD or wavetable synth:
1.
2. Use the Mixer Module to select All as the record source, and adjust the Synth sliders to a 

reasonable level.
3.
4. Load the desired MIDI file into the MIDI Module.

Or, load the desired CD track into the CD Module.
5.
6. From the DAT Module, click on the Record button.

The red LED will blink, indicating that the DAT module is in Record Standby mode.
7.
8.  Click on the DAT Module's Play button to begin recording.
9.
10.Immediately click on the MIDI or CD Module's Play button to start playback of the MIDI file or CD 

track.
While recording, the VU Meters will indicate the record level. If the red LED's light up most of 
the time, you may need to reduce the record level with the Mixer Module.

11.
12.When you're finished recording, click on the DAT Module's Stop button, then click on the other 

module's Stop button.
If you want, click on the DAT Module's Play button to hear what you've just recorded.

13.
14.When you're satisfied, click on the Edit button to access WinDAT, and save the file.
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The MIDI Module

The MIDI Module lets you play back MIDI files using the SPEA MEDIA XTC's built-in wavetable 
synthesizer and/or an external instrument via the optional MIDI connector. It also allows you to record 
song files from an external MIDI keyboard. The Audiostation MIDI Module supports MIDI files in the 
standard .MID format.

Like the other Audiostation modules, the MIDI Module uses a 'home stereo component' interface with 
familiar transport controls, and lets you access a playlist for playing groups of files. From the MIDI 
Module, you can also launch the MIDI Orchestrator, which gives you the ability to edit and modify 
various parameters for each track in your MIDI file, and save the edited file.

When you click on the Play transport button, the MIDI Module will play the MIDI files in the playlist 
sequentially. You can use the Next File and Previous File buttons to scroll through the playlist. The 
current file name is displayed in a window beneath the disk drive graphic, and its file number in the 
playlist is displayed in the Song window.

When a MIDI file is playing or being recorded, the green light on the MIDI Module's disk drive flashes 
to indicate transport activity, and the elapsed time of the file is displayed by the MIN:SEC indicators.

When you play a file, the MIDI Density Meters will show which of the 16 MIDI channels contain active 
data.

Playing MIDI Files

To play a MIDI file:
1.
2. From the MIDI Module, create a playlist as previously instructed.

To play a single file, create a playlist containing one file.
3.
4. From the Playlist window, click on the OK button to return to the MIDI Module with the playlist 

loaded.
5.
6. Click on the MIDI Module's Play button.
7.
8. You can play various files in the playlist by clicking on the Next File and Previous File buttons.

If your MIDI file is playing back through the SPEA MEDIA XTC's built-in wavetable synthesizer, you 
can adjust the playback level with the Mixer Module's Synth sliders.

Editing MIDI Files

To edit a file from the MIDI Module:
1.
2. Load a single file or a playlist into the MIDI Module.

If you've loaded a multi-file playlist, use the Next File or Previous File buttons to access the 
desired MIDI file.

3.
4. From the MIDI Module, click on the Edit button to activate the MIDI Orchestrator.
5.
6. Click on the MIDI Orchestrator's Play button to play the file.

You can modify many of the song's parameters with the MIDI Orchestrator, and hear their effect
in real-time as the song plays back. The available parameters include: channel volumes, tempo,
patches, transposition, etc. These are described in detail in the MIDI Orchestrator chapter.

7.
8. From the MIDI Orchestrator, save the edited MIDI file with either the same name or a new name, 

as desired.
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Recording MIDI Files

The MIDI Module also allows you to record a track from an external MIDI keyboard. However, if you 
want to record with the MIDI Module, you should be aware that it has the following limitations:
·
· All the incoming MIDI data is merged and recorded onto a single track on channel module 1.
·
· The MIDI Module only allows you to make a single 'pass', i.e.: you can't overdub without erasing 

the previous material.

As a result, you can only use the MIDI Module to record either a single-track song (such as a solo 
piano piece), or the first track of a multi-track song. You can then access the MIDI Orchestrator to 
record any additional tracks.

To record a MIDI file, you must have an external MIDI keyboard and the SPEA MEDIA XTC's optional 
MIDI connector.

For purposes of this recording, let's suppose that as you record, you want to monitor your track with 
the SPEA MEDIA XTC's Rock Organ patch, Program 19.

Before recording:
1.
2. Make sure that the MIDI Out of your keyboard is properly connected to the SPEA MEDIA XTC's 

MIDI In.
3.
4. Access the Windows MIDI Mapper and make sure that the current MIDI Map is routing data on 

MIDI Channel 1 to the SPEA MEDIA XTC's wavetable synthesizer. If it is not, you can modify your 
MIDI map.

To record a track with the MIDI Module:
1.
2. Access the MIDI Orchestrator by clicking on the MIDI Module's Edit button.
3.
4. Set the MIDI Orchestrator to the desired Tempo, and enable the Metronome from the Options 

menu.
5.
6. Select Rock Organ (Patch 19) for Channel 1.

If you turn down the volume on your keyboard and play, it should trigger the SPEA MEDIA 
XTC's Rock Organ sound.

7.
8. Close the MIDI Orchestrator by choosing Exit from the File menu.

This will return you to the MIDI Module.
9.
10.Click on the Record button.

The red LED will blink, indicating that the MIDI module is in Record Standby mode.
11.
12.To begin recording, press the Play button.
13.
14.When you're finished recording, press the Stop button.
15.
16.To play back what you've just recorded, click on the Play button.
17.
18.To record additional tracks, you can use the MIDI Orchestrator.

Instructions for recording and overdubbing additional tracks are included in the MIDI 
Orchestrator chapter.

19.
20.When you're satisfied, save the file by choosing Save from Orchestrator's File menu.

If you have a playlist loaded into the MIDI Module, your new song will be inserted as the last file in 
the playlist.

29



Buttons

Power
Closes the MIDI Module

Edit
Launches the MIDI Orchestrator with the current MIDI file loaded. You access the MIDI Orchestrator 
to edit the current MIDI file, set various parameters before recording with the MIDI Module, save a file 
recorded with the MIDI Module, or record additional tracks.

Playlist
Activates the MIDI Module's Playlist window.

Transport Controls
The transport controls are modeled after those found on a standard home tape deck.

Previous
Lets you move to the previous file in the playlist.

[Shift]-click on the Previous button to move to the first file in the playlist.

Next
Lets you move to the next file in the playlist.

[Shift]-click on the Next button to move to the last file in the playlist.

Display

Current File Indicator
The name of the current MIDI file appears just below the disk drive graphic.

Song
Shows the number of the current MIDI file, relative to its position in the playlist.

Play/Pause Indicators
These indicators light up when the MIDI Module is in Play or Pause mode.

MIDIDensityMeters
When you play a MIDI file, these bar-graph meters display the relative density of the MIDI data on 
each of the 16 MIDI channels.

Min:Sec
Displays the amount of elapsed time from the beginning of the current MIDI file.
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Controlling Audiostation with Voice Recognition Software

Audiostation includes keystroke equivalents for each of its commands. This feature lets you control 
Audiostation with voice commands in conjunction with most Windows-based voice recognition 
software.

Typically, voice recognition software allows you to associate one or more keystrokes (called 'key 
macros') with a given voice command. We've included a chart that lists the keystroke equivalent for 
every Audiostation command, along with a recommended voice command for each.

Using the chart below as a guide, simply create a voice command/keystroke template following the 
instructions that came with your voice recognition software. You will also have to properly 'train' the 
voice recognition software to recognize each voice command; refer to your software's instructions for 
information on how to do this.

PowerBar

Key Macro Voice 
Command

F1 Help
F2 Main Power

Mixer Module

Key Macro Voice 
Command

F6 Mixer Power

DAT Module

Key Macro Voice Command

F3 DAT Power
Ctrl-Q DAT Edit
Ctrl-W DAT Playlist
Ctrl-E DAT Previous File
Ctrl-R DAT Next File
Ctrl-T DAT Rewind
Ctrl-Y DAT Stop
Ctrl-U DAT Play
Ctrl-I DAT Record
Ctrl-O DAT Pause
Ctrl-P DAT Fast Forward

MIDI Module

Key Macro Voice Command

F4 MIDI Power
Ctrl-A MIDI Edit
Ctrl-S MIDI Playlist
Ctrl-D MIDI Previous File
Ctrl-F MIDI Next File
Ctrl-G MIDI Rewind
Ctrl-H MIDI Stop
Ctrl-J MIDI Play
Ctrl-K MIDI Record
Ctrl-L MIDI Pause
Shift-Ctrl-P MIDI Fast Forward

CD Module

Key Macro Voice Command

F5 CD Power
Ctrl-Z CD Eject
Ctrl-X CD Playlist
Ctrl-C CD Previous File
Ctrl-V CD Next File
Ctrl-B CD Rewind
Ctrl-N CD Stop
Ctrl-M CD Play
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Shift-Ctrl-Z CD Pause
Shift-Ctrl-X CD Fast Forward

Shift-Ctrl-C CD Mode
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Chapter 2
Windows Digital Audio Transport
WinDAT

Introduction

Voyetra's Windows Digital Audio Transport (WinDAT) is a Windows 3.1 application that allows you to 
play, record and edit digital audio files with your SPEA MEDIA XTC.

WinDAT Features
· Easy-to-use tape deck-style control buttons, a graphic display of the digital audio file, and a variety 

of advanced editing functions.
· You can easily create composite files by cutting, pasting, and mix pasting data from existing files.
· Because WinDAT is a Windows application, you can even activate two instances of WinDAT to 

work on two files at once while cutting and pasting between them.
· WinDAT's Clipboard window provides a convenient way to verify or audition the contents of the 

Clipboard before pasting.
· Extensive support for Object Linking and Embedding (OLE). The end of this chapter contains an 

entire section about using WinDAT's OLE features.
· WinDAT allows you to load files with drag-and-drop from the Windows File Manager and other 

applications that support drag-and-drop file sourcing.



Screen Layout

The WinDAT screen is divided into several sections, as illustrated below:

The Main Screen

· Menu Bar - Pull-down menus, the type common to all Windows applications.
· Transport Controls - Rewind, Stop, Play, Pause, Record, and Fast Forward buttons, just like a 

tape deck.
· Range Controls - Controls for defining and/or playing a specific section of the digital audio file.
· VU Meters - A series of 'LED's' that display the playback or record levels in real time.
· Drag-and-Drop OLE Icon - Allows you to embed sound files into OLE-compatible applications.
· Graphic File Display - Provides a visual representation of the digital audio data, with a Position 

Marker to show the current position. A standard Windows scroll bar indicates the current 
position and lets you scroll through the file in precise increments.

· Status Area - Gives information about the current file: the number of channels (mono or stereo), 
sample rate, bit length, the current position, and the file's total duration.
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WinDAT Tutorial

This tutorial is designed to quickly familiarize you with most of WinDAT's basic functions. It assumes 
that you are already familiar with the basic procedures and methods of Microsoft® Windows, such as 
starting Windows, clicking on icons and controls, choosing menu items, etc. Following the tutorial is a 
detailed reference that describes each of WinDAT's controls and menu items. The final section 
includes information on using some of WinDAT's more advanced features, plus a Troubleshooting 
guide.

Starting WinDAT and Loading a File

To start the WinDAT program:

From the Windows Program Manager, double-click on the WinDAT icon.

You'll find the WinDAT icon in the MEDIAXTC program group that was created during the software 
installation.

To load one of the included digital audio files:
1.
2. Choose Open from WinDAT's File menu. The Files dialog box will appear.

Files List Box
3.
4. From the Format: list box, select .WAV as the desired file format.
5. Navigate to the \MEDIAXTC\SOUNDS directory, where the included digital audio files are located.
6.
7. From the Files list box, double-click on the desired file name, or highlight the desired file name and 

choose Open.

After the file loads, WinDAT will return to its main window.
· The name of the audio file will be displayed in WinDAT's title bar.
· A graphic display of the audio file will fill the bottom half of the screen.
· The length of the file will be displayed in the File indicator at the bottom right of the window, in the 

format [Minutes:Seconds.Hundredths of Seconds].
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Playing a File

Once you've loaded an audio file as described above, you're ready to use WinDAT to play it back. 
Make sure that your SPEA MEDIA XTC is properly connected to your headphones, speakers and/or 
amplifier.

To play a file:

Click the PLAY button in the Transport Controls area.You will hear the digital audio file play through 
your sound system. Playback will stop when the file reaches its end.

Adjusting the Playback Level

If you need to adjust the digital audio playback level of the SPEA MEDIA XTC, you can adjust the 
WAV sliders in Audiostation's Mixer module.

Audiostation and its Mixer Module are detailed in the Audiostation chapter.

To rewind the file:

Double-click the REWIND button in the Transport Controls area.If you want, you can enable the Auto 
Rewind option. When Auto Rewind is enabled, WinDAT will automatically rewind to the start of the file 
every time you stop playing.

To enable Auto Rewind:

Choose Auto Rewind from the Options menu.

Choose Auto Rewind again to disable it.
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Recording with WinDAT

WinDAT can be used in conjunction with your SPEA MEDIA XTC to record virtually any microphone- 
or line-level source.

Before you can record, be sure that the desired audio source (microphone, CD player, tape deck, etc.)
is connected to the appropriate input jack on your SPEA MEDIA XTC. If you're not sure which jack to 
use, refer to the SPEA MEDIA XTC's hardware documentation.

In most cases you'll also need to select the input source, set the recording volume level, and make 
some choices in the Setup dialog box to be sure your file is recorded in the desired format. These 
procedures are described below.

Selecting and Adjusting the Record Source

Setup Dialog Box

The easiest way to select the sound source and to adjust the recording volume to an appropriate level 
is to use Audiostation's Mixer Module. The Audiostation chapter covers this in detail.

To set up WinDAT for recording:
1.
2. From the Windows menu, choose Setup. The Setup dialog box will appear:
3. Select the desired Sample Rate from the Sample Rate combo box. You can choose any of the 

listed sample rates, or type in a sample rate that is supported by your sound card. Refer to your 
sound card's hardware documentation to determine which sample rates it can record with.

4.
5. Select the desired File Format (WAV or VOC).
6.
7. If you've selected WAV as the File Format, select the desired data format from the Data Format 

combo box.
If this is your first time recording with WinDAT, it's probably a good idea to start off by recording 
an 8-bit PCM file. Before you attempt to record a file with data compression, we suggest that 
you read the 'Working with Data Compression' section later in this chapter.

8.
9. Click on the Stereo button to select mono or stereo. The indicator in the upper right corner of the 

Stereo button will appear green when stereo is enabled.
10.
11.When you've completed all your Setup selections, choose OK to return to WinDAT's main window.

When choosing WinDAT's Setup parameters, you should be aware of the following:
· Higher sample rates result in better audio quality; lower sample rates result in a significantly 

smaller file size.
· Although WinDAT can record and play stereo/mono and any data formats that are supported by 

your sound hardware, it cannot convert files between stereo and mono or between different 
data formats.
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· If you enter a sample rate that is not supported by your sound card, WinDAT will display an 
'Unsupported Format' error message when you try to record. Refer to your sound card's hardware 
documentation to determine which sample rates it can record with.

Once you've properly connected the desired audio source to the correct input on your SPEA MEDIA 
XTC and configured WinDAT's Setup parameters, you're ready to record.

To record with WinDAT:
1.
2. If you're recording from a CD-ROM drive, CD Player, or tape deck, cue up the material as needed.
3.
4. Use Audiostation's Mixer module to select the input source and set the record level(s). See the 

Audiostation chapter for details.
5. Click on the RECORD button in the Transport Controls area. The RECORD button's red LED will 

blink, indicating that WinDAT is in Record Standby mode.
6.
7. Click the PLAY button and WinDAT will start recording. The RECORD button's red LED will stop 

blinking and remain lit, indicating that WinDAT is recording.
8.
9. Begin speaking into the microphone, or start the CD-ROM drive, CD player or tape deck.
10.
11.When you've finished recording, click on the STOP button.If Auto Rewind is enabled, WinDAT will 

automatically rewind to the beginning of the file.
12.
13.Click the PLAY button to hear what you've just recorded.

When you're satisfied with what you've recorded, you'll most likely want to save your recording as a 
file.

To save a file:
1.
2. Choose Save from the File menu. The Files dialog box will appear.
3.
4. If you're saving a new file, you will be prompted to type in a file name.
5.
6. Choose OK from the Files dialog box to save the file.

    |
 Selected Range
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Editing Files with WinDAT

WinDAT's versatile editing tools allow you almost unlimited freedom to:

· Copy a section of a file.
· Paste a new section into a file.
· Insert a section of silence into a file.

Range Controls

· Delete a section of a file.
· Combine parts of different files to create new ones.

You could, for example, combine a variety of elements recorded from different sources (speech, 
music, sound effects, etc.) to create a complete digital audio soundtrack for a presentation or other 
multimedia application.

You can even run several instances of WinDAT simultaneously, and use WinDAT's Clipboard to cut, 
copy or paste material between them. The only limits are your computer's system resources and your 
imagination!

Selecting a Range

All of WinDAT's Edit functions require that you specify the section or range of the file that you wish to 
edit. If you've ever used a word processor, this concept will probably seem familiar right away.

The range appears highlighted in reverse on the graphic file display and is indicated numerically in the 
Start and End marker boxes in the Range Controls area. This gives you precise control over the 
selected range. There are several ways to select a range:

To select a range:

Method 1: Click and drag on the Graphic File Display

Click on the desired Start point in the graphic file display, drag to the desired End point, and then let 
go. This will highlight the selected range and load the appropriate values into the Start and End 
markers.

Method 2: Use the Mark Range button
You can mark the Start and End points of a range on-the-fly as you listen to file play back. Play the 
file, and at the beginning of the section you want to select, click on the Mark Range button. Hold the 
button down as the file plays, and release it when you hear the end of the desired section. The range 
will now be highlighted, and the Start and End boxes will display the values for the selected range.

Method 3: Adjust the values in the Marker boxes

Click on the Start or End Marker box and drag up or down to reach the desired Start or End time.

Auditioning the Range

Now that you've selected a range, you'll probably want to hear it so that you can determine if the Start 
and End points need any adjusting.

To audition the Range:
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Press the PLAY RANGE button in the Range Controls area.
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Adjusting the Range

Once you've selected a range, in many cases you'll need to adjust its Start or End points.

To adjust the Start or End point of the range:

Method 1: Click and drag on the Marker boxes
Click on the Start or End Marker box and drag up or down to increase or decrease the Start or End 
time.

Method 2: Click on the the Marker boxes
Click anywhere on the upper half of the appropriate Marker box to increase the Start or End time by 
1/100th of a second. Click anywhere on the lower half of the appropriate Marker box to decrease the 
Start or End time by 1/100th of a second.

Method 3: [Shift]-click on the Graphic File Display
From the Graphic File Display, move the mouse cursor to the desired location and [Shift]-click. This 
will move the Start or End point (whichever is nearer) to the new location. The other point will not be 
affected.

Using the Edit Functions

Now that you know how to select, audition, and adjust the range, you're ready to try out some of 
WinDAT's Edit functions.

 

To remove a section of a file:
1.
2. Select the range of the file that you wish to remove.
3.
4. Choose Cut from the Edit menu.
5.
6. Play the file to hear the results of the edit.

Cut deletes the selected range from the file and places it in the Clipboard. The rest of the file is shifted
back to fill in the gap, similar to what happens when you delete text in a word processor.

The Paste command is used to insert the contents of the Clipboard at a specified point in either the 
current file or a different file.

To paste the contents of the Clipboard into a file: 
1.
2. If you haven't already done so, use Cut to place some data in the Clipboard, as described above.
3.
4. Choose Clipboard from the Windows menu to verify that the data has actually been placed in 

WinDAT's Clipboard.
5.
6. Click on the Clipboard's PLAY button to audition what you've just placed there.
7.
8. If you want to Paste into a different file, load that file, or, choose New from the Files menu to paste 

into a new file.
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9.
10.If you're pasting into an existing file, select the point where you want to paste the Clipboard 

contents by designating it as the Start point.
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If you're pasting into a new file, the data will be pasted starting at 0.00.

6.
7. Choose Paste from the Edit menu.The contents of the Clipboard will be inserted at the designated 

Start point. Any data after that point will be shifted to the right, similar to inserting text in a word 
processor.

The method for using the rest of WinDAT's Edit functions is essentially the same. A complete 
description of each Edit function and menu item is contained in the later reference section.

To execute any Edit function:
1.
2. Select the range.
3.
4. Choose the desired menu item from the Edit menu.

To undo the most recent Edit or Transform:

Choose Undo from the Edit menu.

Modifying files with the Transforms

WinDAT includes a category of functions called 'Transforms'. The Transforms allow you to make 
useful modifications to your digital audio files. 

Like the Edit functions, the Transforms also operate on a selected range.

The Scale Transform is used to increase or decrease the loudness (amplitude) of the selected range 
by a specified factor between .01 and 10.00. For example, a scaling factor of 2.0 would double the 
loudness; a scaling factor of 0.5 would half the loudness.

The Scale function is useful for matching loudness between different files when you're cutting and 
pasting between them. We'll use Scale as an example of how to execute a Transform.

To Scale the loudness (amplitude) of a selected range:
1.
2. Select the range you want to scale, or choose Select All from the Edit Menu to select the entire file.
3.
4. Choose Scale from the Transforms menu. The Scale dialog box will appear.
5.
6. Place your mouse pointer on the slider as shown and drag it up or down to the desired scaling 

factor (between .01 and 10). When you've selected the scaling factor, choose OK to execute the 
Scale transform.

The method for using the remainder of WinDAT's Transforms is essentially the same. A complete 
description of each Transform function and menu item is contained in the reference section.
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To execute any Transform:
1.
2. Select the range.
3.
4. Choose the desired menu item from the Transforms menu.

To quit WinDAT:

Choose Exit from the File menu.

Screen Areas and Controls

Transport Controls

Since the Transport Controls are modeled after a tape deck, they will be familiar to you if you've ever 
used a cassette deck or VCR.

REWIND
Double-clicking the REWIND button scrolls backward to the beginning of the file (0.00).

Clicking the REWIND button scrolls backward by one second. If the file is less than ten seconds long, 
clicking the REWIND button scrolls backward by one tenth of the file's length.

STOP
Clicking the STOP button stops playback or recording.

PLAY
Clicking the PLAY button initiates playback of the file. Playback always starts from the current position
in the file, as displayed by the Cur (Current) position indicator in the Status Area.

When WinDAT is in Record Standby mode, clicking the Play button starts recording.

PAUSE
Click on the PAUSE button to momentarily stop recording or playing.

To resume, click again on the PAUSE button or click on the PLAY button.

RECORD
Click on the RECORD button to toggle WinDAT in and out of Record Standby mode. When WinDAT is
in Record Standby mode, the RECORD button's red LED will blink.

When WinDAT is in Record Standby mode, click the PLAY button to start recording. When WinDAT is 
recording, the RECORD button's red LED will remain lit.

FAST FORWARD
Double-clicking the FAST FORWARD button scrolls forward to the end of the file.
Clicking the FAST FORWARD button scrolls forward by one second. If the file is less than ten 
seconds long, it will scroll forward by one tenth of the file's length.
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Keyboard Equivalents for the Transport Buttons

As an alternative to the mouse, you can control the playback and recording of an audio file with your 
PC's keyboard. The following is a chart of the keyboard equivalents for the Transport buttons:

Keyboard Commands for 
Transport
[Space Bar] Play
[ or ] (Either Bracket Key) Play Range
[Enter] Stop
< Rewind
> Fast Forward
P Pause
R Record

Range Controls

The Range Controls let you select a precise portion of the file for playing, editing or transforming.

The selected portion of a file is referred to as a 'range', and is defined by its Start and End times in 
seconds. The Start and End times can be specified to a precision of 1/100th of a second.

MARK RANGE button
The Mark Range button lets you mark a portion of a file 'on-the-fly' as you listen to it play back.

When you hear the beginning of the section you want to mark, click and hold on the Mark Range 
Button. Release the mouse button when you hear the end of the section you want to mark.

If necessary, you can adjust the Start and End times by clicking and dragging up or down in the Start 
and End Marker boxes.

PLAYRANGE button
Clicking the Play Range button initiates playback of the currently-selected range.

Start Markerbox
Displays the Start time of the currently-selected range in the format: 
[Minutes:Seconds.Hundredths of seconds].
· Click on the Start Marker box and drag up or down to increase or decrease the Start time.
· Click anywhere on the upper half of the Start Marker box to increase the Start time by 1/100th of a 

second.

Status Area

· Click anywhere on the lower half of the Start Marker box to decrease the Start time by 1/100th of a 
second.

End Markerbox
Displays the End time of the currently-selected range in the format: 
[Minutes:Seconds.Hundredths of seconds].
· Click on the End Marker box and drag up or down to increase or decrease the End time.
· Click anywhere on the upper half of the End Marker box to increase the End time by 1/100th of a 

second.
· Click anywhere on the lower half of the End Marker box to decrease the End time by 1/100th of a 

second.
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Graphic File Display

The central portion of WinDAT's main window contains the Graphic File Display. It provides a visual 
representation of the digital audio file that is currently loaded into WinDAT.

The horizontal axis represents time (moving from left to right); the vertical axis represents amplitude 
(loudness). Since WinDAT displays the entire file, the amount of time represented by the Graphic File 
Display varies with the length of the file.
A red line, called the Position Marker, displays the current position in the file. During playback, it 
moves from left to right across the Graphic File Display.

The bottom of the Graphic File Display contains a standard Windows-style scroll bar, which can be 
used to scroll forward or backward through the file in small increments.

The selected range is displayed in reverse highlight.
· To select a range with the mouse, point to the desired Start point, click and drag to the desired End

point, then release the mouse button.
· Click anywhere in the Graphic File Display to clear the range selection.
· Double-click anywhere in the Graphic File Display to select the entire file.

Status Area

The Status Area is located below the graphic file display. It contains information about the current 
audio file (Mono/Stereo, Sample Rate, Bit Length and File Length).

Mono/Stereo
Indicates whether the audio file is mono or stereo.

Sample Rate (kHz)
Displays the sample rate of the currently loaded audio file.

Bit Length (Bits)
Displays the bit length of the current digital audio file.

Compressed files in ALaw or mLaw format will display 8-bit.

Cur(Current)
Displays WinDAT's current position in the digital audio file, in the format [Minutes:Seconds.Hundredths
of Seconds].

File
Displays length of the file, in the format:[Minutes:Seconds.Hundredths of Seconds].

47



Menu Items

File Menu

New
Creates a new, empty file based on the settings in the Setup window.
· Choosing New does not erase the contents of the Clipboard.
· Since WinDAT always replaces any loaded file when you record, it is not necessary to choose New

before recording.

Open
Presents a dialog box to select the file you want to load.

The Files dialog box also allows you to select which file extension (VOC or WAV) you want it to look 
for.

Save
Saves the current file to disk.

If the file already has a name, it will be saved with that name. Otherwise, the Save As... dialog box will
appear.

Save As...
Presents a dialog box for naming and saving the current file to disk.

Exit
Terminates the WinDAT program.

File List(1 2 3 4)
The bottom portion of WinDAT's File menu lists the last four audio files that you have opened or 
saved, with the most recently-opened file listed at position 1.

To open an audio file in this list, simply click on the desired file name.

The File List gives you a convenient way to re-open any of the last four files you've worked on.
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Edit Menu

Undo
Restores the file to the state it was in before the last Edit or Transform operation.

Cut
Removes the selected range and shifts the rest of the file back to fill in the gap, similar to deleting text 
in a word processor. The deleted data is placed in WinDAT's Clipboard.

Copy
Puts a copy of the selected range in the Clipboard without altering the file.

Paste
Inserts the contents of the Clipboard at the Start point and shifts any data after that point to the right.

Mix Paste
Mixes the contents of the Clipboard with the data in the current file, beginning at the Start point.

Select All
Selects the entire file as the range.

Use Select All when you want to perform an Edit or Transform operation on the entire file.

Delete
Deletes the selected range, but does not copy the data to the Clipboard.

Erase
Puts a copy of the selected range in the Clipboard and replaces it with silence.

Trim
Deletes all data except the selected range. The contents of the clipboard remain unchanged.

Change Speed dialog box

Trim is useful for removing unwanted sound at the beginning or end of a newly-recorded file.

Insert Silence
Inserts a specified interval of silence (from .01 to 10 seconds) at the Start point, shifting any data after 
that point to the right. The Insert Silence dialog box presents you with a slider to select the duration of 
the silence.
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Transforms Menu

Normalize
Increases the amplitudes in the selected range as follows: the peak value is converted to the 
maximum possible amplitude, all the other amplitude values are scaled accordingly.

Use Normalize to optimize the signal-to-noise ratio of files that have been recorded at too low a level, 
without the possibly of introducing distortion (as can happen with the Scale transform).

Find Peak

Scans the selected range and:
· Displays a pop-up window reporting the value and location of the peak amplitude.
· Sets the Start point marker and the Current position to one second before the peak amplitude 

occurs.
· Sets the End point marker to 1 second after the peak amplitude occurs.

Find Peak is useful for locating an unwanted peak so that it can be Scaled or Deleted; or for finding 
the beginning of a word in a speech file.

Scale
Scales the amplitudes (loudness) in the selected range by a factor ranging from 0.00 to 2.00.

Scale is useful for matching the loudness of two files before performing a Paste or Mix Paste 
operation.

WAV -> VOC or VOC -> WAV
Converts 8-bit WAV files to the Sound Blaster VOC format, or VOC files to 8-bit WAV format.

ChangeSpeed
This transform allows you to change the speed and pitch of a digital audio file by changing it to a 
different sample rate.
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Options Menu

Auto Audition
When Auto Audition is enabled, you can audition different files from the Files list box.

Enable Auto Audition in the Options menu, then choose Open or Save As... from the Files menu. 
When you click on a file name in the Files list box, WinDAT will play that file.

Auto Audition lets you audition different files by simply clicking on them from the Files list box.

Auto Rewind
When Auto Rewind is enabled, WinDAT will automatically return to the beginning of the file when it 
stops playing.

Auto Rewind eliminates the need to manually rewind to the beginning of a file every time you're 
finished playing it.

NoWave
When No Wave is enabled, the Graphic File Display will disappear and WinDAT's entire window will 
shrink vertically.

When you click on No Wave again to disable it, the Graphic File Display will return and WinDAT will be
restored to its previous window height.

Setup Dialog Box
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The No Wave feature is handy if you want to minimize WinDAT's size so that it can share your 
desktop with other applications. Additionally, it saves time by eliminating the wait normally required for 
re-drawing the Graphic File Display, especially when you're working with large files. No Wave can also
help reduce the amount of system overhead when playing back files at high data rates.

Playback VU
When the Playback VU option is enabled, WinDAT's VU Meters will be active during playback. 
Disabling the VU meters can help to reduce system overhead if you're experiencing problems playing 
back files at high data rates.

   Stop  Play

Record VU
When the Record VU option is enabled, WinDAT's VU Meters will be active during recording. 
Disabling the VU meters can help to reduce system overhead if you're experiencing problems 
recording at high data rates.
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Windows Menu

Tune Performance Dialog Box

Setup
Displays the Setup dialog box from which you can choose the settings for a file prior to recording. For 
details, see the 'Recording with WinDAT' section earlier in this chapter.

The Setup window also allows you to select the directories that WinDAT will use for its Work and 
Temp directories. As with most Windows applications, the Work directory is the default directory that 
WinDAT will use when opening or saving files; the Temp directory is where WinDAt will temporarily 
store your original data as .TMP files when you perform Edit or Transform functions so that they can 
be Undone if necessary. 
· WinDAT automatically detects and lists all of the data formats/compression schemes supported by 

your sound card and its Windows WAV driver.
· If you enter a sample rate that is not supported by your sound card, WinDAT will display an 

'Unsupported Format' error message when you try to record. Refer to your sound card's 
hardware documentation to determine which sample rates it can record with.
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· When you choose OK from the Setup window, its settings are saved as WinDAT's new defaults.
· When a file is loaded, the Setup dialog box will always display the settings that the file was saved 

with.
· Because WinDAT cannot 'intelligently' convert sample rates, changing the sample rate of a file will 

cause a change in its playback speed and pitch.

Drag and Drop - a quick way to load files

· Data pasted from the Clipboard will play back at the sample rate of the file it is pasted into.
· Some of the data formats use compression schemes to reduce the file size of your recording. This 

saves disk space, but can reduce the sound quality, and the resulting file may be incompatible with 
other sound cards or software programs. For a detailed discussion of compression, refer to 
'Working with Data Compression' later in this chapter.

Clipboard
Activates a window that displays information about the contents of WinDAT's Clipboard:
· From: - The name of the file that the data was Cut or Copied from,
· Sample Range: - The starting and ending sample numbers, referenced to the file that the data 

was Cut or Copied from.
· # Samples: - The duration of the data, in number of samples.
· Duration: - The duration of the data, in the format [Minutes:Seconds.Hundredths of Seconds].
· Sample Rate: - The sample rate of the data in the Clipboard.
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· Format: - The bit length and mono/stereo setting of the data in the Clipboard. The Clipboard 
window also allows you to audition the contents of the Clipboard before performing a Paste or Mix 
Paste operation.

To audition the contents of the Clipboard, click on the Clipboard window's Play button.To stop 
playback, click on the Stop button.

WinDAT uses its own Clipboard format, which allows it to share data with OLE Client applications and 
other Voyetra programs, such as AudioView, Annotator, etc. It is not to be confused with the regular 
'Windows Clipboard'.

Tune Performance
The Tune Performance window lets you adjust various parameters to optimize WinDAT's 
performance, or to minimize problems playing/recording at high data rates.

In general, you should only modify the default Tune Performance settings if you're experiencing data 
rate problems. Such problems are indicated either by a file that cuts-off abruptly, or by a 'Disk Could 
Not Keep Up With Digital Audio' error message.
· Play Buffer (default=4 seconds) - Determines the size of the memory buffer that WinDAT will use 

during playback.
· Record Buffer (default=8 seconds) - Determines the size of the memory buffer that WinDAT will 

use during recording.
· Pre-Write (default=128 K Bytes) - When you're preparing to record, the Pre-Write setting will 

determine the size of the area on your hard drive that WinDAT will 'pre-allocate' for the digital audio
data (in kBytes). This gives WinDAT access to a contiguous area of the disk, minimizing the 
overhead required to record the data.

For more information on using Tune Performance, refer to the later 'Troubleshooting' section.

File Info
Activates a window that displays information about the contents of WinDAT's currently-loaded file.
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Using Drag-and-Drop File Loading

WinDAT supports drag-and-drop file loading from the File Manager or other file management utilities 
that support drag-and-drop file sourcing, such as Norton Desktop for Windows, XTree for Windows, 
etc. This feature lets you load a digital audio file by simply clicking on the file name and dragging it into
WinDAT.

To load a file into WinDAT with drag-and-drop:
1.
2. Run the Windows File Manager (or other drag-and-drop compatible application).
3.
4. From the File Manager, navigate to the directory where the desired file is located so that the file 

name is displayed.
5.
6. Click and hold on the file name, and drag it into WinDAT.
7.
8. Release the mouse button anywhere inside WinDAT's Graphic File Display.The file is now loaded 

into WinDAT.

Many third-party Windows file management utilities support drag-and-drop file sourcing. To find out 
whether yours does, refer to its documentation or contact the manufacturer.

Working with Data Compression

The Windows driver for the SPEA MEDIA XTC is capable of recording and playing back digital audio 
data using two different compression schemes: ALaw and mLaw. WinDAT allows you to take 
advantage of this feature.

Data compression can significantly reduce the size (and therefore the storage requirements) of digital 
audio files. However, if you're recording a file to be played back on a number of different systems, or 
with a number of different applications, you may not want to use compression.

Keep these considerations in mind as you decide whether to use data compression:
· Compressed files can be played back only on digital audio hardware that supports the same 

compression scheme.
· Not all software applications support playback of compressed files (even if the sound hardware 

does).
· WinDAT cannot perform any Edit or Transform functions on compressed files. If you record or load 

a compressed file, the waveformwill not be displayed in the Graphic File Display. Instead, the 
phrase 'Cannot display compressed wave' will appear.

· While data compression can provide a significant reduction in file size, it also reduces audio quality.
In general, compression is most appropriate for speech or other situations where high fidelity is not 
essential.

WinDAT's VU Meters are not displayed when you record or play back data in a compressed format 
(i.e.: anything other than 8- or 16-bit PCM). This is because WinDAT cannot instantaneously calculate 
the level of compressed data.

If you have trouble getting a useable level when trying to record a compressed file, switch to 8- or 16-
bit PCM in the Setup window, use the VU meters to adjust your record level as needed, then switch 
back to the compressed format and record your file.
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Loading .VOC Files into WinDAT

Compressed

Various other software products on the market can save .VOC files in compressed form using 
proprietary 'Sound Blaster'-type compression. Since Windows does not support playback of 
compressed .VOC files, WinDAT will display an 'Unsupported Audio File Format' error message if you 
attempt to play back such a file.

Multi-chunk

Other products, such as Creative Labs' Voice Editor and Voice Editor II, can save .VOC files in a 
'multi-chunk' format. WinDAT is capable of loading and playing multi-chunk .VOC files, as long as they
are not compressed (see above). If you do load a multi-chunk .VOC file, WinDAT will give you the 
option of either converting the file to the 'non multi-chunk' .VOC format, or loading the file without 
converting it.

· If you choose to convert the file, WinDAT will convert it to the 'non multi-chunk' .VOC format. You 
will be able to view, Edit, or Transform the file in the normal fashion.

· If you choose not to convert the file, its waveform will not be displayed in the Graphic File Display; 
instead, the words 'Multi-Chunk' will appear. You will not be able to perform any Edit or Transform 
operations on the file.
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Using WinDAT's OLE Features

WinDAT supports a feature of Windows 3.1 called Object Linking and Embedding, or OLE. OLE 
enables you to place data from one application into a document created by another application, even if
the two applications use very different types of data. For example, with OLE you can place recorded 
sound into a word processor document or spreadsheet.

Here are a few definitions which will help you understand the basic concepts of OLE:
· OLE object: The data that you insert into an OLE-compatible document. In the case of WinDAT, 

we'll also refer to this as a 'sound object'.
· OLE Server: An application capable of creating objects that can be embedded or linked into an 

OLE-compatible document. WinDAT is an OLE Server.
· OLE Client: An application capable of accepting embedded or linked objects OLE objects. OLE 

Client applications include: Windows Write, Word for Windows, Microsoft Excel, and many others.

Linking vs. Embedding

There are two different types of OLE objects: linked objects and embedded objects. To use WinDAT's 
OLE features effectively, it's important to understand the differences between linking and embedding:

Linking

A linked object is a reference, or link, to a file which has been created and saved by an OLE Server 
application. In the case of WinDAT, this means that you must save your recording as a file before you 
can link it into a document.

Advantages:
· You only need one copy of the object no matter how many times it appears. This helps saves disk 

space.
· When you edit a linked object, the edited version will automatically appear in all documents that 

have a link to that object.

Disadvantages:
· You cannot use linking to insert a portion of a file into a document, as you can with embedding.
· If you want to distribute your OLE document to another user, you must include all of the files to 

which the document is linked, and the other user must duplicate the paths to those files.
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The quickest way to embed a sound file
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Embedding

In contrast to linking, an embedded object actually becomes a part of the Client document. With 
embedding, you can embed either an entire file or the contents of the Clipboard into a document. In 
the case of WinDAT, this means that you have the option of embedding either your entire recording, or
just a part of it.

When you edit an embedded object, the change is only applied to that object; copies embedded 
elsewhere remain unaffected.

Advantages:
· Embedding allows you to insert a portion of a file as an object via the Clipboard.
· Embedded objects are saved along with the document, which makes the document easier to 

distribute to another user.

Disadvantages:
· Because every instance of an embedded object is a separate copy, embedding can consume a lot 

of disk space.
· If you edit an embedded object, additional instances of that object are not automatically updated, 

as they are with linking.

For a more complete discussion of OLE, refer to your Windows Users Guide.
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WinDAT's OLE Support
WinDAT includes extensive support for OLE:
· WinDAT functions as an OLE Server, allowing you to embed or link sound objects into documents 

created with any OLE Client.
· Since it's an OLE Server, you can use WinDAT to edit sound objects from within the document 

itself, without having to separately run WinDAT.
· WinDAT includes a unique drag-and-drop OLE icon, which lets you conveniently embed sound 

objects into an OLE Client by simply dragging and dropping the icon at the desired point in the 
document.

When you link or embed a sound object from WinDAT into an OLE client, WinDAT places an icon at 
the appropriate point to represent the sound object.

WinDAT supports several different methods for inserting sound files into OLE-compatible documents:

Using the Drag-and Drop OLE Icon

In most cases, you'll simply want to embed an entire sound file into a document. The easiest way to 
embed an entire sound file is to use WinDAT's drag-and-drop OLE icon.

To embed a sound file in a document:
1.
2. Load or record the desired sound file into WinDAT.
3.
4. Drag WinDAT's drag-and-drop OLE icon to the desired point in the destination document and 

release the mouse button.

Embedding a Portion of a Sound File

If you want to embed just a portion of a sound file into a document, you can do so by copying the 
desired data to WinDAT's Clipboard and then the using the standard OLE methods to embed it.

To embed a selected part of a sound file in a document:
1.
2. Load or record the desired sound file into WinDAT.
3.
4. Highlight the desired range in the Graphic File Display and copy it to the Clipboard by choosing 

Copy from WinDAT's Edit menu.
5.
6. Click on the desired insertion point in the destination document.
7. To embed the sound data that was copied to WinDAT's Clipboard, choose Paste from the 

document's Edit menu.
8.
9. If you're creating a link and the sound file has not been saved yet, save it now.

Creating a Sound Object Link

If you want to use WinDAT to create an OLE link, simply use the standard OLE methods , as further 
detailed in your Windows Users Guide.

To Link a sound object:
1.
2. Load or record the desired sound file into WinDAT.
3.
4. If the sound file has not been saved yet, do so by choosing Save for WinDAT's File menu.
5.
6. Click on the desired insertion point in the destination document.
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7.
8. Choose Paste Link from the document's Edit menu. This will create a link to the entire sound file.

WinDAT does not support the ability to embed compressed files into OLE documents.

Working with Sound Objects

Once you've inserted a WinDAT sound object into a document, you'll probably want to play it back to 
verify that the recording has has been correctly inserted.

To play a WinDAT sound object:
· From within the document, double-click on the WinDAT icon representing the embedded or linked 

sound object you wish to play.
· Or, click on the desired icon and choose Sound [VOY] Object, Play from the document's Edit 

menu.

One of the main advantages of OLE is that it allows you to edit objects from within the document itself,
without having to separately run the OLE Server application. In other words, you can edit a WinDAT 
sound object without having to actually run WinDAT.

To edit a WinDAT sound object:
1.
2. From the document, click on the WinDAT icon representing the embedded or linked sound object 

you wish to edit.
3. From the document's Edit menu, choose Sound [VOY] Object, Edit.This will cause WinDAT to run, 

with the sound object already loaded.
4.
5. From WinDAT, edit the sound object as needed.
· If you're editing an embedded sound object, choose Update [application name] from WinDAT's File 

menu.
· If you're editing a linked sound object, choose Save from WinDAT's File menu. NOTE: This will 

overwrite the original sound file.

Tune Performance Dialog Box
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Troubleshooting

Because of the somewhat complex nature of digital audio, sound hardware, and the Windows 
environment, it's possible that you may encounter a problem using WinDAT with your system. If you 
have any problems, first try following these steps:

Check the instructions.
Go through the instructions carefully, to make sure you didn't miss anything.

Check your connections.
If WinDAT seems to be working correctly, but you just can't hear any sound, check the connections 
between the SPEA MEDIA XTC and your sound system (amplifiers, speakers, etc.).

Is it a problem with the installation of the SPEA MEDIA XTC itself?
If the sound card came bundled with a test or diagnostic utility, run it. This will tell you if the problem is 
being caused by improper configuration or installation of the SPEA MEDIA XTC hardware itself. Refer 
to the SPEA MEDIA XTC's hardware documentation.

Is it a problem with the installation of the SPEA MEDIA XTC's .WAV driver?
The Media Player or the Sounds applet in the Windows Control Panel are good ways to test for proper
installation of the SPEA MEDIA XTC's .WAV driver. If you can't get these or any Windows program to 
play digital audio, then it's most likely a problem with the installation or configuration of the .WAV 
driver.

Try re-installing the SPEA MEDIA XTC's .WAV driver by running the software installation again. Make 
sure to enter the correct hardware settings (IRQ, I/O address, DMA).

If none of the procedures above solve the problem, carefully read through the rest of this 
Troubleshooting section. It will help you identify and solve some of the more common problems 
encountered with WinDAT.

Data Rate Problems

The complexity of recording and playing back digital audio on a PC tends to push even the most 
powerful systems to their limit. Consider that recording 44 kHz at a resolution of 16 bits requires 
moving almost 100K of audio data between your sound hardware and hard disk in one second!

In some instances when playing or recording digital audio, your hardware may not be able to keep up 
with this data rate. This is especially likely if you have a slower computer, hard drive, or CD-ROM 
drive and attempt to play high sample rate, 16-bit, stereo files. The symptom of this problem is a 
filethat starts to play and then quits, seems to cut in and out, or sounds 'broken up.' This is usually 
accompanied by a 'Disk could not keep up with digital audio' or similar error message. If this occurs, 
it's often possible to correct or minimize the problem using one or more of the techniques outlined 
below:

Avoid Playback from a CD-ROM Drive

Because they're so much slower than hard drives, you'll be much more likely to experience data rate 
problems when attempting to play back high data rate files from a CD-ROM drive. If possible, copy the
file to your hard drive and play it back from there.

Adjust the Tune Performance options
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WinDAT includes a number of Tune Performance options that can help you optimize performance 
when using high data rates. These options can be accessed by choosing Tune Performance from the 
Windows menu.

Play and Record Buffers
· If you're experiencing data rate problems during playback, try increasing the value of the Play 

Buffer.
· If you're experiencing data rate problems during recording, try increasing the value of the Record 

Buffer.
You should only increase the size of WinDAT's Play and Record Buffers as much as is necessary to 
assure good performance. Changing them to a larger value than is necessary merely wastes memory.
If you increase a buffer value to the point where it exceeds the amount of available memory, WinDAT 
will display an 'Unable to allocate enough memory' error message when you attempt to play or record.

Pre-Write

If your hard disk has an extremely long access time, or if it tends to become fragmented often, you 
can use the Pre-Write feature to determine the size of the area on your hard drive (in bytes) that 
WinDAT will 'pre-allocate' for the incoming digital audio data. This gives WinDAT access to a 
contiguous area of the disk, thus minimizing the overhead required to record data to it.

If you encounter data rate problems when recording, try increasing the Pre-Write value. It should be 
equal to the maximum size of the file you'll be recording (in Kilobytes).

De-fragment your hard disk

Digital audio performance will suffer if your hard disk becomes fragmented, that is, one or more of the 
files on your hard disk are stored in small fragments at numerous, scattered locations. Severe disk 
fragmentation will cause your hard disk to have problems keeping up with high digital audio data rates.

Disk fragmentation can become especially severe due to the large disk partitions supported by recent 
versions of DOS. For best results, you should regularly use one of the many commercial disk 
optimizing utilities that are available. Optimize your hard disk often.

Create a 'digital audio' disk partition

If your hard disk tends to become fragmented often, you may want to create a separate partition of 20 
MB or so exclusively for digital audio. Refer to your DOS manual for information on how to partition 
your hard drive. From WinDAT's Setup window, assign this new partition as the Temp Directory.

Use a data format that is less demanding

If you're recording and you encounter a 'Disk could not keep up with digital audio rate' error message, 
try using a less demanding data format.
· Try decreasing the sample rate.
· If you're attempting to record 16-bit audio, try switching to 8-bit.
· If you're recording in stereo, try switching to mono.

Reduce System Overhead

Reducing the amount of demand or 'overhead' on your system can sometimes make the difference 
with data rate problems. Here are a few ways to reduce system overhead:
· Try running Windows in Standard instead of 386 Enhanced mode. Compared to Windows' 

Standard mode, 386 Enhanced mode uses quite a bit more system resources and tends to slow
down hardware access in general.

· Close any unnecessary Windows applications. Other Windows applications that are open could be 
making demands on system resources. Try closing any Windows applications that you don't 
need.
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· Use WinDAT's No Wave option to disable the Graphic File Display. This can improve performance 
significantly, since your system no longer needs to devote any of its resources to displaying the 
waveform during playback.

· Disable the Record VU or Playback VU option.
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Digital Audio Format Mismatches

Symptom:
'Unsupported Audio File Format', 'Invalid Bit Length', or ' Invalid Sample Rate' error message.

Solutions:
WinDAT is designed to work with all Windows-compatible digital audio hardware, and therefore lets 
you open and edit any standard WAV or VOC file. However, if you try to play back a file whose format 
(sample rate, bit length, mono/stereo setting, etc.) is not supported by your sound hardware, WinDAT 
will display one of the above error messages. Refer to the SPEA MEDIA XTC's hardware 
documentation to determine its digital audio implementation.

Driver-Related Problems

Symptoms:
· 'Audio driver not found - Audio functions disabled' error message.
· WinDAT causes a Windows 'General Protection Fault'.

Solutions:
These symptoms usually indicate that the SPEA MEDIA XTC's .WAV driver is either missing or 
incorrectly configured.
1.
2. Use the Control Panel's Sounds applet or the Media Player to check digital audio playback. If you 

can't play digital audio from these applications either, then the problem is most likely with the 
installation or configuration of the .WAV driver.

3.
4. From the Control Panel's Drivers applet, choose Setup to verify that the SPEA MEDIA XTC's .WAV

driver is configured to use the correct IRQ, I/O address, DMA channel settings, etc. If not, change 
the settings to the correct values, then re-start Windows and run WinDAT again.

If re-configuring the .WAV driver from the Control Panel doesn't solve the problem, re-install the .WAV
driver by simply running the software installation again. Make sure to enter the correct hardware 
settings (IRQ, I/O address, DMA).
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Chapter 3
MIDI Orchestrator

Introduction

The MIDI Orchestrator plays, records, and arranges MIDI files in the Windows environment. Best of 
all, you can hear the effect of your changes on-the-fly as the song plays back. With the MIDI 
Orchestrator you can:

· Modify and customize an existing MIDI file.
· Add new tracks to an existing MIDI file.
· Create multi-track MIDI compositions from scratch.

The MIDI Orchestrator's channel-based 'mixing console' approach makes it easy to balance the 
volume of each channel, transpose tracks, set the song tempo, and set the patch (instrument sound) 
used by each channel. The MIDI Orchestrator provides just the right amount of control for customizing
your MIDI files, or for optimizing them for playback on your particular sound card or MIDI synthesizer.
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Screen Layout

The Orchestrator screen is divided into several areas, as illustrated on the opposite page:

· Menu Bar - A series of pull-down menus, the type found in all Windows programs.
· Transport Controls - Contains Rewind, Stop, Play, Pause, Record, and Fast Forward buttons, 

just like a tape deck.
· Song Position - Displays the current location in the song file, and lets you move to any desired 

location within the song by simply dragging the pointer with your mouse.
· Tempo and Tempo Offset - These controls display, and allow you to set, the song tempo and a 

tempo offset. 
· Channel Modules - These make up the main part of the MIDI Orchestrator. There are 16 different 

channel modules, one for each of the 16 MIDI channels, which allow you to set various 
parameters for the MIDI data contained on that channel (volume, patch, name, etc.).

· Status Area - Displays information about the current file and the status of the MIDI Orchestrator 
itself.

How the MIDI Orchestrator Works

Before using the MIDI Orchestrator, it's important to understand how it differs from a full-featured MIDI
sequencing program.

Orchestrator does not address MIDI data in terms of tracks as a sequencer does. Rather, it arranges 
and controls MIDI data on the basis of its MIDI channel assignment. 

The Orchestrator contains 16 channel modules, one for each MIDI channel. The channel modules let 
you independently control the volume and patch for each MIDI channel, and also name and transpose 
individual tracks.

Playback

While each of the Orchestrator's channel modules may contain one or more musical tracks (parts), all 
the tracks in a particular channel module are merged into a single data stream assigned to that MIDI 
channel. Thus, all the tracks in a given channel module will share the same volume and patch 
assignment on playback. 

If a channel module contains more than one track, the individual tracks will be listed when you open 
the module's Channel Info dialog box. You can assign transposition values and a name independently 
for each track in a channel module.
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Recording

When you record, the MIDI Orchestrator merges all the incoming MIDI data and places it into any and 
all channel modules for which recording is enabled, regardless of the MIDI channel assignment of the 
incoming data. Thus, you determine the channel module into which a part will be recorded by clicking 
on the Record Enable buttons for the desired module or modules. 

The MIDI Mapper

The Orchestrator uses the Windows Control Panel's MIDI Mapper as its output device. You determine 
whether a given channel module will trigger the SPEA MEDIA XTC's built-in wavetable synthesizer 
and/or an external MIDI device (via the SPEA MEDIA XTC's optional MIDI connector ) by selecting the
desired Port Name for that channel in the MIDI Mapper. 

Which MIDI map should you use?

Unless you chose not to do so, the installation will have already created a default MIDI map for you. 
This default MIDI map will route song data on channels 1-10 to the SPEA MEDIA XTC's built-in 
wavetable synthesizer. If you're just going to be playing back song files through the wavetable synth, 
this default MIDI map is the one that you'll want to use. 

The installation will have also installed a second MIDI map that will route data on channels 1-10 to the 
optional MIDI connector. If you're going to be playing back song files through external MIDI devices 
only, you should access the MIDI Mapper and switch to this MIDI map instead.

If you're going to be using both the built-in wavetable synth and external MIDI devices, you will need to
either modify one of the default MIDI maps or create a new one from scratch. For information on these
procedures, refer to the Microsoft Windows Users Guide.

Which channel modules should you use?

The channel modules that you'll be using to play and record will depend on the type of sound card 
and/or MIDI devices in your setup:
· If you're using the wavetable synth or an external General MIDI device (both of which are 

categorized as Extended devices), use channel modules 1-9 for melodic parts and channel 
module 10 for the drum part.

· If you're using an external non-General MIDI device, refer to its documentation to determine which 
MIDI channels it responds to.

· Channels 11 & 12 are usually not used
· Use channels 13-16 for Base Level Sound Cards
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Using the MIDI Orchestrator

There are two ways to run the MIDI Orchestrator: 

Method 1:

Double-click on the Orchestrator icon, just as you would to run any Windows program. 

Method 2:
From Audiostation's MIDI Module, click on the Edit button.

Loading and Playing a MIDI Song File

When you run the MIDI Orchestrator from its own icon, you load a file by choosing Open from the File 
menu, just as you would with any other Windows program. When you launch the MIDI Orchestrator 
from Audiostation's MIDI Module, it automatically loads the song file that is currently loaded into the 
MIDI Module from the playlist. 

Before playing a song file, make sure the Windows MIDI Mapper is properly configured to route the 
song data as needed: to either the SPEA MEDIA XTC's built-in wavetable synthesizer, or to an 
external MIDI device via the MIDI connector. 

To load and play a MIDI file:
1.
2. If the song file isn't already loaded, choose Open from the Files menu. 
3.
4. From the Open dialog box, navigate to the appropriate Drive and Directory. If you want to load one 

of the included MusiClips files, navigate to the MEDIAXTC\SONGS directory. Then double-click on 
the filename of the desired song.
· When the song file loads into the MIDI Orchestrator, you'll notice several things:
· The song's name will appear in the Orchestrator's title bar.
· The Volume sliders will adjust themselves to the correct level for each channel that contains 

MIDI data.
· The Total Time and Total Bars indicators will display the length of the song.

3. Click on the Play button to play the song. 

As the song plays, you'll notice several things:

· The Status indicator will display Playing.
· The MIDI Density Meters will indicate the relative number of notes being played on each 

channel.
· The Song Position indicator will advance from left to right.
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Modifying Song File Parameters

One of the MIDI Orchestrator's most useful features is the ability to load an existing MIDI file, change 
various aspects of the file in real time as you listen to it play back, and then re-save it when it's suited 
to your particular taste or purpose. 

The Orchestrator lets you modify:

· Channel parameters: volume, patch, solo, mute, and assign a name for each channel. 
· Track parameters: individually transpose and name each track assigned to a channel.
· Global parameters: tempo, tempo offset (for songs with a tempo map), and file name.

Adjusting Channel Volumes

Each of the MIDI Orchestrator's channel modules contains a volume slider, or 'fader', that you can 
control with your mouse. You can use the volume sliders to adjust the relative balance among the 
channels -just as you would with a studio mixing console.

The volume sliders adjust each channel's MIDI Volume to a value between 1 and 127. When you save
a song file, each channel's MIDI Volume is also saved. As a result, the relative balance for all the 
tracks will be retained, even when you use a different application to play back the song (Media Player, 
Audiostation's MIDI Module, a MIDI sequencing program, etc.). 

The Volume sliders will function with the SPEA MEDIA XTC's on-board wavetable synth and any 
external MIDI devices which respond to MIDI Volume messages. The sliders will have no effect on 
devices that don't respond to MIDI Volume.

To adjust the channel volumes:

As you listen to the song file play back, drag the slider knobs up or down as needed to achieve the 
desired balance among the channel modules.

Or, click above or below a slider knob to increase or decrease the volume by 10.

Patch Assignments

With the MIDI Orchestrator you can assign a patch (sound) to each channel, or change the patch 
assignments in an existing MIDI file to suit your taste. For example, you could load one of the included
MusiClips files and change the patch assignment of the Flute Solo track, turning it into a saxophone 
solo.

You can also change patches as the song plays. This feature allows you to audition the effects of 
different sounds on-the-fly and choose the best one for each part.

When you save a file in MIDI Orchestrator, each channel's patch assignment is saved along with the 
file. Your new file will always call up the correct patches for each channel, even when you use a 
different application to play it back (Media Player, Audiostation's MIDI Module, a MIDI sequencing 
program, etc.). 

Like most sound cards and MIDI instruments, the MIDI Orchestrator uses patch numbers ranging from
1-128.
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If you don't assign a patch to a channel module, that channel will use either the instrument's default 
patch or the last patch that was called up on that channel. A 'no patch assignment' condition for a 
channel module is indicated by a hyphen 'Ä' in the Patch Selector and by the words 'NONE' in the 
Channel Info dialog box.

A chart listing the General MIDI patches and their corresponding MIDI patch numbers is included later 
in this chapter. Refer to this chart if you're using the SPEA MEDIA XTC's built-in wavetable 
synthesizer or an external General MIDI device, such as the Roland Sound Canvas, Yamaha TG100, 
etc. If you're using an external non-General MIDI device, refer to its documentation for a listing of its 
available patches. 

There are two ways to select the sound for a channel: you can use the channel module's Patch 
Selector control, or you can assign a patch from the Channel Info dialog box. 

To assign a patch with the Patch Selector:

Patch Selectors

1.
2. Click on the top half of the Patch Selector control to increase the value, click on the bottom half to 

decrease the value. 
Or, click on the Patch Selector control and drag up or down.

3. If the MIDI Orchestrator is playing, you'll hear the sound change as you call up different patches.

To assign a patch from the Channel Info dialog box:

1.
2. Click on the channel module's Channel Info button.
3.
4. From the Channel Info dialog box, click on the desired patch name in the Patch list box.
5.
6. When you've selected the patch, click on the OK button to close the dialog box.

The new patch number will be displayed in the channel module's Patch Selector control. 
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Mute and Solo 

Each channel module includes a Mute button and a Solo button. The Mute button lets you silence a 
channel; the Solo button lets you mute all the channels except that channel. Using the Mute and Solo 
buttons, you can do things like isolate a part for closer inspection, or audition and compare alternate 
'takes' on different channels.

When they are enabled, the Mute and Solo buttons' LED indicators will be illuminated.

To solo or mute a channel:
1.
2. Click on the channel module's Solo or Mute button.
3.
4. Click on the button again to disable Solo or Mute.

You can also solo a group of channels by holding down the [Ctrl] key while clicking on the Solo buttons
for each of the desired channel modules. 

Naming Tracks and Channel Modules 

The MIDI Orchestrator lets you name or re-name tracks. To name a track, you access the Channel 
Info dialog box.

To name or re-name a track:
1.
2. Click on the channel module's Channel Info button.

The Channel Info dialog box will appear.

3.
4. From the Tracks on Channel list box, click on the track you wish to re-name. If it's a newly-

recorded track, it will be listed as New.
That track name will appear in the Selected Track edit box at the lower left.

5.
6. From the Selected Track edit box, type in the desired name.

Once you assign a name to a track, the first few characters of the name will appear in the channel 
module's Tk Name area. As you move the mouse over each channel module's Tk Name area, the 
window will expand to display the full name.

If a channel module contains more than one track, the name of the first track will appear in the Tk 
Name area. Thus, you can give each channel module a Tk Name by editing the name of the first track.
The Tk Name makes it easy to identify what's on each channel at a glance.

To name a channel module: 
1.
2. From the Channel Info dialog box, select and edit the first track listed in the Tracks on Channel list 

box, using the method described above. 
3.
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4. Close the Channel Info dialog box and return to the MIDI Orchestrator's main screen. The name 
will now be displayed in the channel module's Tk Name area.
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Transposing Tracks

You can use the MIDI Orchestrator's Channel Info dialog box to transpose the pitch of any track by 
octaves or by semi-tones. If a channel module contains more than one track, you can transpose each 
track independently.
When you save a song, the notes in any transposed tracks are converted and saved with their new 
pitch values.

To transpose a track:
1.
2. Click on the Channel Info button of the channel module containing the track you want to transpose.

The Channel Info dialog box will appear.
3.
4. If there is more than one track listed, select the track you wish to transpose by clicking on its name 

in the Tracks on Channel list box.
That track name will now appear in the Selected Track box.

5.
6. To transpose the pitch of the selected track up by octaves, click on the top half of the Octave 

numerical. Click on the lower half to transpose the track down by octaves. 

Use the Semi numerical in the same manner to transpose by semi-tones.

Tempo and Tempo Offset

The Tempo control lets you set or change the song's playback tempo. With the Tempo Offset control 
(labeled +/-), you can also choose a tempo offset. Both controls display their current values in Beats 
Per Minute (BPM). 

Some song files will use the same tempo all the way through. Other song files will contain a tempo 
map consisting of one or more embedded tempo changes.

· If you're working with a single-tempo song, the Tempo control will display the song's tempo and will
let you adjust its value. 

· If you're working with a song containing a tempo map, the Tempo control will display the current 
tempo, and it allows you to adjust each of the individual tempos contained in the tempo map. 

In either case, the new tempo values are saved when you save the song file.

To adjust the tempo:
1.
2. If the song contains a tempo map, use the transport buttons as needed to locate the section whose

tempo you wish to change.
If necessary, you can click on the Pause button to pause playback at that point. 

3.
4. Click and drag the mouse up or down on the Tempo control as needed.

Or, click on the upper part of the Tempo control to increase the tempo by 1 BPM, click on the 
lower part to decrease it by 1 BPM.

5.
6. When you save the file, it will be saved with the new tempo value.
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The Tempo Offset control allows you to add or subtract a specified amount to/from the song's tempo 
value(s). If a song contains a tempo map, the Tempo Offset control will affect all of the tempo values 
by the same amount. For example, let's suppose your song contains a tempo map that goes from 115 
BPM to 133 BPM, and then back to 115 BPM for the ending. If you enter a tempo offset of -10, the 
song will now play back at 105 BPM, 123 BPM, and 105 BPM. Each value in the tempo map will have 
been offset by -10.

When you save a song for which you've entered a tempo offset, the MIDI Orchestrator will apply the 
tempo offset and save the file with the resulting new tempo value(s). For example, if your song has a 
tempo of 120 BPM and a tempo offset of +10, the MIDI Orchestrator will save it with a new tempo of 
130 BPM. 

To enter a tempo offset:
1.
2. Click and drag the mouse up or down on the Tempo Offset control as needed.

Or, click on the upper part of the Tempo Offset control to increase the offset value by 1 BPM, 
click on the lower part to decrease it by 1 BPM.

3.
4. When you save the song, the Orchestrator will add or subtract the tempo offset to/from any tempo 

values in the song, and save it with the new value(s). 

Recording with the MIDI Orchestrator

When you record with the MIDI Orchestrator, all the incoming MIDI data, regardless of its MIDI 
channel assignment, is merged and placed into all channel modules for which recording is enabled. 
Thus, you determine the channel module or modules into which a part is recorded by clicking on the 
Record Enable button for each desired module.

Normally you'll want to record your part into a single channel module. However, in some cases you 
might want to record a part onto more than one channel so that you can 'double' the part on more than
one instrument.

Recording with MIDI Orchestrator requires the SPEA MEDIA XTC's optional MIDI connector and a 
MIDI keyboard. 

Before recording:
· Make sure the MIDI Out of your keyboard is connected to the SPEA MEDIA XTC's MIDI In. If 

you're not sure how to do this, refer to the SPEA MEDIA XTC's hardware documentation.
· If you're recording a part that will be using one of the SPEA MEDIA XTC's built-in wavetable 

sounds, check the Windows MIDI Mapper to make sure that the current MIDI map is routing the 
appropriate MIDI channel(s) to the SPEA MEDIA XTC's wavetable synthesizer. This will allow you 
to monitor your playing with the actual sound while you record.
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To record a track with the MIDI Orchestrator:
1.
2. From the Options menu, enable the Metronome if necessary. 
3.
4. Set the desired tempo using the Tempo control. 
5.
6. Select the channel module or modules into which you wish to record by clicking on their Record 

Enable buttons. The red LED on the Record Enable button will be illuminated to indicate that the
module is enabled.

7.
8. For each channel module you'll be recording into, use the Patch Selector to choose the patch that 

you want to use for monitoring while you record.
If you turn down the volume on your MIDI keyboard and play, you should now hear it trigger the 
selected patch on the SPEA MEDIA XTC's wavetable synthesizer.

9.
10.When you're ready to record, click on the Record button. 

The Record button's red LED will blink, indicating that the MIDI Orchestrator is in Record 
Standby mode.

11.
12.To begin recording, click on the Play button. The Record button's red LED will illuminate, indicating 

that the Orchestrator is recording.
You should now hear the metronome counting out the tempo from the PC speaker. 

13.
14.While listening to the metronome, play your part on the MIDI keyboard.

If you make a mistake, you can click on the Stop button and start over again by repeating steps 
5 and 6.

15.
16.When you've finished recording your part, click on the Stop button to stop recording.
17.
18.To play back what you've just recorded, click on the Play button.

If you make a mistake while recording, you can click on the Stop button and then use the Fast 
Forward and Rewind buttons or the Song Position slider to locate the bar where you made the 
mistake. Once you've done this, you can start recording your part from that point onward. 

The MIDI Orchestrator can record different parts onto each of the 16 MIDI channels. Once you've 
recorded your first part, you can record additional parts onto other channels, as you play along with 
the parts that you've already recorded. This technique is called overdubbing, and is done in much the 
same way as you would in a professional recording studio.

To overdub additional parts:
1.
2. Select a new channel module to record onto by clicking on its Record Enable button.
3.
4. Use that channel module's Patch Selector to choose the sound for your new part. 
5.
6. Follow the same procedure as when recording the first track.

Once you've recorded your new song (or added new tracks to an existing song), you can use any of 
the MIDI Orchestrator's controls to customize it: adjust the relative channel volumes, assign patches 
for each channel, name each track, transpose tracks, select a song tempo, etc. 

77



When you're satisfied with the song, you can save it by choosing Save from the File menu.

Recording Drum Parts

If you want to record a drum part using the SPEA MEDIA XTC's wavetable synth or other MIDI device,
be sure to assign it to the correct MIDI channel:

· If you're using the SPEA MEDIA XTC's FM synth, use channel 16 for the drum part. 
· If you're using the SPEA MEDIA XTC's built-in wavetable synth or an external General MIDI 

device, use channel 10 for the drum part.. 
· If you're using a non-General MIDI external device, refer to its documentation to determine the 

channel that it uses for drums.

At the end of this chapter you'll find a listing of the General MIDI Drum Note assignments which will let
you determine which note will trigger a given General MIDI drum sound. This chart will come in handy 
when you're recording a drum part for the SPEA MEDIA XTC's wavetable synth or other General MIDI
device.

MID vs. ORC Files

MIDI Orchestrator allows you to open and save song files in both the standard MIDI (.MID) and 
Voyetra's proprietary Orchestrator (.ORC) format. 

In most cases you'll probably want to use the standard .MID format for compatibility with almost all 
available PC MIDI applications. However, if a file is going to be shared with another application that 
supports .ORC files, such as Voyetra's MIDI Orchestrator Plus, you may want to save your song in the
.ORC format.
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Screen Areas and Menus

Channel Modules

The MIDI Orchestrator contains a channel module for each of the 16 MIDI channels. Each module 
includes the following screen elements and controls (from the top down):

Info
(Channel Info) Click on the button to access the module's Channel Info dialog box.

MIDI DensityMeter
Graphically indicates the relative number of notes being played on that MIDI channel. 

Solo
Mutes all other channel modules. Use the Solo button to make it easier to hear a particular channel.

To 'solo' multiple channel modules, hold down the {Ctrl] key while clicking on the desired Solo buttons.

Mute
Silences playback of that channel.

Rec
(Record Enable) When activated, routes incoming MIDI data to the channel for recording. All incoming
MIDI data, regardless of its channel assignment, is recorded onto every enabled channel.

Patch 
(Patch Selector) Sets the patch (sound) to be used by that channel module. The patch number can be
any value from 1-128. The Patch Selector lets you change sounds by transmitting a MIDI Program 
Change message. 

When the Patch Selector is disabled, as indicated by a '-', no Program Change message is 
transmitted. In this case, the synthesizer will play whatever patch was most recently assigned to that 
channel, or the synthesizer's default patch.
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Volume 
These sliders let you increase or decrease the playback volume of each channel, so you can create a 
'mix' for your song, just as with a real mixing console. The volume sliders control each channel's 
loudness by transmitting MIDI Volume messages.

The Volume sliders will function with the SPEA MEDIA XTC's on-board wavetable synth and any MIDI
devices that respond to MIDI Volume messages. 

Tk Name
This area displays a name for each channel module. In most cases, this is the name of the track 
contained on that channel module. If the module contains more than one track, the Tk Name area 
displays the name of the first one. 

Normally, only the first few characters of each track name are visible. As you move your mouse 
pointer over each window, it expands to display the full track name.

Channel Info Dialog Box

Click on a channel module's Channel Info button to access its Channel Info dialog box.

Tracks on Channel
Lists the names of all the tracks contained in the channel module, and allows you to select a track for 
naming or transposing.

To name or transpose one of the tracks, highlight its name in the Tracks on Channel list box. When 
the track name appears in the Selected Track box, type a new name for the track, or use the 
Transpose controls to change pitches.

Selected Track
Displays the currently-selected track that you wish to name or transpose.

Transpose
Allows you to transpose the selected track up or down by octaves and/or semi-tones. Click on the top 
or bottom half of the desired control to raise or lower the pitch.

Patch
Allows you to select a patch (sound) for that channel, just like the channel module's Patch Selector 
control. 
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Transport Controls

The MIDI Orchestrator's transport controls are similar to those found on a tape deck. From left to right,
they are:

Rewind 
Click on the Rewind button to scroll backward in 1-bar increments.

Double-click on the Rewind button to return to the beginning of the song.

Stop
Click on the Stop button to halt playback or recording. 

Play
Click on the Play button to start playback from the current song position.

If the Orchestrator is in Record Standby mode, click on the Play button to start recording.

Record
Toggles the MIDI Orchestrator in or out of Record Standby mode. Once in Record Standby mode, 
click on the Play button to start recording.

Pause
Click on the Pause button to temporarily halt playback or recording at the current song position.

Click on the Pause button again to resume.

FastForward
Click on the Fast Forward button to scroll forward in 1-bar increments.Double-click on the Fast 
Forward button to advance to the end of the song.

Song Position

The Song Position slider provides a visual indication of the current song position. The Status area (see
below) provides a more precise display of the current position.

You can grab the pointer with the mouse to move to any position within the song.
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Tempo Controls

There are two tempo controls:

Tempo
Displays, and allows you to set, the current song tempo. 

+/-
(Tempo Offset) Allows you to increase or decrease the tempo(s) for an entire song by a specified 
amount.

Status Area

The Status area has five windows which display information about the current song file and the status 
of the MIDI Orchestrator itself. From left to right:

Status
Displays the MIDI Orchestrator's current status: Stopped, Playing, Paused, (Record) Standby, or 
Recording.

Current Time
Displays the elapsed time from the beginning of the song, in the format Minutes:Seconds.

Total Time
Displays the total length of the song, in the format Minutes:Seconds.

The length of the song in minutes:seconds takes the tempo setting into account; if you increase 
(speed up) the tempo, the song length will decrease.

Current Bar
Displays the current song position, in the format Bars:Beats.

Total Bars
Displays the total length of the song, in the format Bars:Beats.
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Menus

File Menu

New
Opens a new, empty file.

Open
Presents a dialog box to select the file that you wish to load. 

Save
Saves the currently-loaded file to disk.

If the file already has a name, it will be saved with that name. Otherwise, the Save As... dialog box will
appear.

Save As...
Presents a dialog box for naming and saving the current file to disk. 

Exit
Exits MIDI Orchestrator, returns you to Windows Program Manager.

1/2/3/4
(File List) Lists the paths of the four most recently opened files. To open a listed file, click once on its 
entry.

Options Menu

Metronome
When Metronome is enabled, the MIDI Orchestrator will produce a short tone from the PC speaker for
each beat. You can use the metronome as a timing reference while recording. 

Save Settings on Exit
When the Save Settings on Exit option is enabled, the current Metronome setting is saved whenever 
you quit the MIDI Orchestrator.
MIDI InputDevice
Allows you to select a MIDI input device for recording.

The Orchestrator always uses the Windows MIDI Mapper as its MIDI output device. 

Help Menu

Contents
Activates the MIDI Orchestrator's on-line Help system.

AboutMIDIOrchestrator...
Presents the MIDI Orchestrator's About... box, containing the program's revision number and creation 
date.
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General MIDI Patch Map
Piano
1 Acoustic 
Grand Piano
2 Bright 
Acoustic Piano
3 Electric Grand

Piano
4 Honky-tonk 
Piano
5 Rhodes Piano
6 Chorused 
Piano
7 Harpischord
8 Clavinet 

Chromatic 

Percussion 
9 Celesta
10 Glockenspiel
11 Music box
12 Vibraphone
13 Marimba
14 Xylophone
15 Tubular Bells
16 Dulcimer 

Organ 
17 Hammond 
Organ
18 Percussive 
Organ
19 Rock Organ
20 Church Organ
21 Reed Organ
22 Accordion
23 Harmonica
24 Tango 
Accordion 

Guitar 
25 Acoustic 
Guitar (nylon)
26 Acoustic 
Guitar (steel)
27 Electric Guitar 

(jazz)
28 Electric Guitar 

(clean)
29 Electric Guitar 

(muted)
30 Overdriven 
Guitar
31 Distortion 
Guitar
32 Guitar 
Harmonics

Bass 
33 Acoustic Bass
34 Electric Bass 

(finger)
35 Electric Bass 

(pick)
36 Fretless Bass
37 Slap Bass 1
38 Slap Bass 2
39 Synth Bass 1
40 Synth Bass 2 

Strings
41 Violin
42 Viola
43 Cello
44 Contrabass
45 Tremolo 
Strings
46 Pizzicato 
Strings
47 Orchestral 
Harp
48 Timpani 

Ensemble 
49 String 
Ensemble 1
50 String 
Ensemble 2
51 SynthStrings 1
52 SynthStrings 2
53 Choir Aahs
54 Voice Oohs
55 Synth voice
56 Orchestra Hit 

Brass
57 Trumpet
58 Trombone
59 Tuba
60 Muted 
Trumpet
61 French Horn
62 Brass Section
63 Synth Brass 1
64 Synth Brass 2 

Reed 
65 Soprano Sax
66 Alto Sax
67 Tenor Sax
68 Baritone Sax
69 Oboe
70 English Horn
71 Bassoon
72 Clarinet 

Pipe
73 Piccolo
74 Flute
75 Recorder
76 Pan Flute
77 Bottle Blow
78 Shakuhachi
79 Whistle
80 Ocarina 

Synth Lead 
81 Lead 1 
(square)
82 Lead 2 
(sawtooth)
83 Lead 3 
(caliope lead)
84 Lead 4 (chiff 
lead)
85 Lead 5 
(charang)
86 Lead 6 (voice)
87 Lead 7 (fifths)
88 Lead 8 (bass 
+ lead) 

Synth Pad
89 Pad 1 (new 
age)
90 Pad 2 (warm)
91 Pad 3 
(polysynth)
92 Pad 4 (choir)
93 Pad 5 (bowed)
94 Pad 6 
(metallic)
95 Pad 7 (halo)
96 Pad 8 (sweep)

Synth Effects 
97 FX 1 (rain)
98 FX 2 
(soundtrack)
99 FX 3 (crystal)
100 FX 4 

(atmosphere)
101 FX 5 
(brightness)
102 FX 6 (goblins)
103 FX 7 (echoes)
104 FX 8 (sci-fi) 

Ethnic 
105 Sitar
106 Banjo
107 Shamisen
108 Koto
109 Kalimba
110 Bagpipe
111 Fiddle
112 Shanai 

Percussive
113 Tinkle Bell
114 Agogo
115 Steel Drums
116 Woodblock
117 Taiko Drum
118 Melodic Tom
119 Synth Drum
120 Reverse 
Cymbal 

Sound Effects 
121 Guitar Fret 
Noise
122 Breath Noise
123 Seashore
124 Bird Tweet
125 Telephone
126 Helicopter
127 Applause
128 Gunshot
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General MIDI Drum Note Map

MIDI Note #/Drum 
Sound

MIDI Note #/Drum 
Sound

35 Acoustic Bass Drum 59 Ride Cymbal 2
36 Bass Drum 1 60 High Bongo
37 Side Stick 61 Low Bongo
38 Acoustic Snare 62 Mute High Conga
39 Hand Clap 63 Open High Conga
40 Electric Snare 64 Low Conga
41 Low Floor Tom 65 High Timbale
42 Closed High Hat 66 Low Timbale
43 Hi Floor Tom 67 High Agogo
44 Pedal High Hat 68 Low Agogo
45 Low Tom 69 Cabasa
46 Open Hi Hat 70 Maracas
47 Low-Mid Tom 71 Short Whistle
48 High-Mid Tom 72 Long Whistle
49 Crash Cymbal 1 73 Short Guiro
50 High Tom 74 Long Guiro
51 Ride Cymbal 1 75 Claves
52 Chinese Cymbal 76 High Wood Block
53 Ride Bell 77 Low Wood Block
54 Tambourine 78 Mute Cuica
55 Splash Cymbal 79 Open Cuica
56 Cowbell 80 Mute Triangle
57 Crash Cymbal 2 81 Open Triangle
58 Vibraslap 



Chapter 4
Say It!

Introduction

Say It! lets you use the SPEA MEDIA XTC's digital audio capabilities to add voice and sound 
annotation to many different types of Windows documents, such as those created with: Windows 
Write, Word for Windows, Microsoft Excel, Lotus AmiPro, and many others.

Compared to other voice annotation programs that require complicated menu commands, Say It uses 
a much more convenient method for embedding voice notes into your documents. You simply activate 
Say It by pressing a 'hot key', speak into your microphone, then click on the Accept button. The sound
file is automatically embedded into your document at the current cursor position!



Object Linking and Embedding (OLE)

Say It! takes advantage of a feature of Windows 3.1, called Object Linking and Embedding or OLE. 
OLE enables you to place information from one application (an object) into a document created by 
another application, even if the two applications use very different types of data. For example, one 
might not normally think of placing recorded sound into a spreadsheet, but OLE makes this possible.

To use Say It, you really don't need to be familiar with all the particulars of OLE. However, a brief 
explanation of some OLE-related terms will help you get the most out of the program.

Servers and Clients

OLE applications fall into two categories: servers and clients:

· Applications which create objects that can be embedded or linked into other applications are called 
OLE servers.

· Applications that can accept embedded or linked objects are called OLE clients.

Say It is an OLE server application. When you embed a voice note into an OLE client, a copy of the 
Say It icon is placed at the appropriate point to represent the sound object you created with Say It. 

Linking vs. Embedding

Linked and embedded objects are deceptively similar in function and appearance. You should 
understand the important differences between the two:

· When you embed an object in a document, you create a unique copy of that object which is saved 
as a part of the client document. If you change an embedded object, the change applies to that 
single instance of the object only. Copies embedded elsewhere remain unaffected. Because 
every instance of an embedded object is an independent copy, embedding can consume a lot of
disk space.

· When you link an object to a document, all you really do is place in the client document a 
reference, or link, to the original object. Thus you only need one copy of the object, no matter how 
many times it appears. This approach saves disk space but any changes you make to the object 
are automatically reflected in every client document that contains a link to the original -something 
you may not always want.

Say It embeds sound into client documents. If you wish to link  a sound file to an OLE client 
document, you should use an OLE server application which supports Linking, such as Voyetra's 
WinDAT or AudioView. 

For a more complete discussion of OLE, consult your documentation for Windows and your OLE 
applications.



Quick Start with Say It!

To load Say It, locate the Say It icon in the Program Manager and double-click on it.

Say It always loads as a minimized application. It appears as a icon on your Windows desktop waiting 
for you activate it.

After you start Say It, all your Windows applications will display a new menu item in their system 
menus: 'Record Note Ctrl-R.'

Before recording a voice note, go through the following steps:

· Make sure Say It is loaded, as indicated by the icon appearing in the lower left corner of the 
Program Manager. 

· Using your OLE client application, create or open the document. 
· Connect your microphone to the appropriate input on the SPEA MEDIA XTC. 
· Use Audiostation's Mixer Module to select Mic as your recording source and adjust its record level 

to a reasonable value.

To record a voice note:
1.
2. Select a destination for your voice note by clicking on the desired point in the document.
3.
4. Activate Say It by pressing the Hot Key, [CTRL]-R. 

([CTRL-R] is the default Hot Key. The procedure for changing the hot key is described later in 
this chapter).

When you press the Hot Key, the Say It window will appear, and it will immediately start 
recording your voice note. 

5.
6. Speak into the microphone.
7. When you've finished speaking, click on the 'Accept' button.

Say It will return to its minimized state and your voice note will be automatically embedded at the 
destination point you selected in step 1. The voice note will be represented as a copy of the Say It 
icon within your document. 



Other Recording Tools

Say It gives you several ways to recover from mistakes and to make sure you're satisfied with your 
recording before you embed it:

To pause during recording:
1.
2. Click on the Pause button to temporarily halt recording without losing the material you've already 

recorded. 
3.
4. Press the pause button again to resume recording from the point where you left off.

You can use the Spacebar in place of the Pause button.

Use only the Pause button or the Spacebar to resume recording. If you use the Record button, Say It 
will erase the existing recording and start a new one.

To listen to a recording before you embed it:
1.
2. Press the stop button.
3.
4. Click on the Play button to hear what you've just recorded.
5.
6. If you're satisfied, click on the Accept button to embed the voice note.

If you want to re-record, follow the instructions below.

To re-record a voice note before you embed it:
1.
2. Click once on the record button.

Say It will go into 'Record Standby' mode, and the red light on the record button will blink.
3.
4. When you are ready to begin another take, click on the Play button or the Pause button. Say It 

deletes the first recording and starts making a new one in its place.

You can repeat this process as often as you need to.
3. Press the 'Accept' button when you are satisfied with your recorded message.

To cancel a voice note:

Press the Cancel button or the [C] key at any time. The current recording will be erased and Say It will
return to its minimized state.

Playing Voice Notes

You, or anyone else that has Say It installed, can play back your voice notes.

To play a voice note:
1.
2. From the document, double-click on the Say It icon representing the voice note you want to play.

Or, click on the desired icon and choose ©Say It Objectª, then ©Playª from the document's Edit 
menu.

3.
4. You can stop playback of the voice note before it finishes by pressing the left mouse button.

Usually you'll find an item like the one illustrated above in the Edit menu of the client application. 
However, some OLE clients provide access to these commands in different ways. In Microsoft Excel, 



for example, you click the right mouse button. Check the documentation for your application to find out
how it works with OLE objects.



Changing Voice Notes

There are two ways in which you can change a voice note after it has been embedded in a document. 
You may cut, copy or move it to a new location in the same client or in another client. And you may 
replace an existing voice note altogether.

To cut, paste, or delete voice notes:
1.
2. Select the voice note icon embedded in your document.
3.
4. Use the client application's Cut and Copy commands in the normal manner. 

The voice note is now in the OLE client's Clipboard. You can paste it to a different point in the same 
document, or into another OLE client document.

The cut, copy or paste commands may vary in how they work, depending on the capabilities of the 
OLE client application. Check the program's documentation if you encounter problems.

To replace an existing voice note:
1.
2. Select the Say It icon embedded in the document.
3.
4. Activate Say It, or choose 'Say It Object', then 'Edit' from the client application's Edit menu.

Say It will start again.
5.
6. Record your new version of the voice note.
7.
8. Click on the 'Accept' button.

Your new voice note will replace the existing one.

Editing Voice Notes

Say It does not permit you to edit your voice notes directly. However, you can use Say It's Copy and 
Paste commands to transfer voice notes to and from WinDAT. This way you can edit voice notes with 
WinDAT, or convert previously recorded sound files into voice notes:

To edit a voice note with WinDAT:
1.
2. Select the voice note in the OLE client document.

3. Choose 'Say It Object', then 'Edit' from the client application's Edit menu.
(Some OLE client applications may provide access to editing commands in a different manner. 
Check the documentation for details.)

Say It will start again.
4.
5. From the Say It Edit menu, select copy.
6.
7. Activate or run WinDAT. From the WinDAT Edit menu, select Paste.

The voice note will load into WinDAT, and its sound data will appear in WinDAT's Graphic File 
Display.

8.
9. Edit the file in WinDAT.
10.
11.From the WinDAT Edit menu, choose Select All, then Copy.
12.
13.From Say It's Edit menu, select Paste.

A copy of the edited voice note will now be loaded back into Say It.



14.
15.Select 'Accept' from Say It The edited voice note will be inserted into the OLE Client, replacing the 

original.



To place a previously-recorded file as a voice note:
1.
2. Place your cursor at the desired destination in the OLE client application.
3.
4. From the OLE Client, activate Say It. 
5.
6. Activate or run WinDAT.
7.
8. Use WinDAT to open an existing file. You may edit the file in WinDAT if you wish.
9.
10.Select the part of the file you wish to embed in your OLE client, or choose Select All from the 

WinDAT Edit menu.
11.
12.From the WinDAT Edit menu, select Copy.
13.
14.From the Say It Edit menu, select Paste.

15.Click on 'Accept'.
Say It will embed the file in the OLE Client.

Any time you are using WinDAT and Say It together, keep WinDAT open until you have completed the
entire process.WinDAT holds the data in its own clipboard during some steps.



Say It! and Non-OLE Applications

Because Say It cannot detect which applications support OLE, it puts the 'Record Note' menu item 
into the system menus of all your Windows applications. Thus, you can activate Say It from any 
application's system menu, but if that application is not an OLE client, your recording will appear to be 
lost when you press the 'Accept' button. Actually, the recording is not lost; it is in the Clipboard and 
can be retrieved. 

To retrieve a 'lost' recording:
1.
2. Switch to the application into which you want to embed your voice note. Be sure that the 

application is an OLE client.
If no OLE clients are running, you may start one. Windows Write is a good choice.

3.
4. Place your cursor in the desired position.
5.
6. From the client's Edit Menu, select Paste.

The voice note will be pasted at the location of the cursor. 
7.
8. You can now save the file if you wish, or cut, copy or move the voice note to its final destination at 

your convenience -as long as the destination is in an OLE client application.

Take the steps above immediately. If you use any command that places data in the Windows 
Clipboard (e.g., Cut, Copy), or if you exit Windows before you retrieve your voice note, you will not be 
able to recover it.

How Voice Notes Affect File Size

Say It always records in 8-bit mono at a sample rate of 11.025 KHz. The chart below will give you an 
idea of the increases you can expect in a document's file size when you embed voice notes.

Length of 
Recording

Increase in File 
Size

5 seconds 55 KB
10 seconds 110 KB
15 seconds 165 KB
30 seconds 331 KB
1 minute 662 KB
2 minutes 1.32 MB

To calculate how much a file will increase in size, use this formula:Length of Recording (in seconds) x 
11.025 = File Size Increase (in Kilobytes)



Say It! Controls and Menus

Transport Buttons

Stop
Stops recording or playback, or cancels Record Standby

To stop playback when you are playing back a voice note from within the client document, press the 
left mouse key.

Play
Plays back the current recording, allowing you to listen to it before you Accept it.

In Record Standby mode, starts recording. The red indicator turns on (bright red) during recording. If 
you have an existing recording that you have not Accepted, that recording will be lost.

Record
Turns Record Standby on or off. The red indicator blinks during record standby mode.

Pause
During recording, allows you to pause without losing the current recording. Press pause a second time
to continue.

During playback, allows you to pause and resume playback of your recording.

In Record Standby mode, starts recording. The red indicator turns on (bright red) during recording. If 
you have an existing recording that you have not Accepted, that recording will be lost.

Scroll bar 

During recording, the thumb shows how much of the maximum recording time you've used. (See 
'Maximum Length' section for details.)



During playback, the thumb shows the current position relative to the length of the recording.

To play back from a specific point in the file, use your mouse to move the thumb to the desired 
position on the scroll bar, then press the Play button.

Time Indicators

Maximum
Displays the current maximum allowable recording time. The procedure for adjusting the maximum 
length is described below.

Current 
Displays your current position in the file in minutes:seconds. 

Status Indicator

Shows what Say It is doing - 'Record Standby', 'Recording', 'Playing', 'Paused' or 'Stopped'.

Accept/Cancel Buttons

Accept
Stops recording and automatically embeds the voice note into the selected destination (the most 
recent cursor location) in the client application.

Cancel
Erases the current recording and returns Say It to its minimized state.

VU Meter

A vertical column of 'lights' at the right edge of the Say It window that flash to display playback or 
record levels.

In general, you should adjust your record level so that the red lights blink occasionally as you speak 
into the microphone. If they stay lit most of the time, or if they don't light at all, you can adjust the 
record level as necessary with Audiostation's Mixer module, or you can simply adjust your speaking 
volume and/or the position of the microphone.

In addition to 8- and 16-bit PCM, the drivers for the SPEA MEDIA XTC and the applications in this 
package also support the ability to play back and/or record .WAV files using the ALaw and mLaw data 
compression schemes. 

Keyboard Equivalents for Buttons

Many of Say It's mouse-activated functions can also be controlled from your computer's keyboard:

Button Keystroke
Stop S
Play P
Record R
Pause Spacebar
Accept A, Enter
Cancel C, Esc



Menus

Edit Menu

Copy
Places the current recording into the Windows Clipboard. This permits you to transfer a recording into 
a digital audio editor such as WinDAT or AudioView or to embed it in a document using the OLE 
client's Paste command.

Paste
Places digital audio data from Say It's Clipboard into Say It itself. 

After you paste data into Say It, you can press the 'Accept' key to embed it in your client document.

Say It's Clipboard will only accept data from applications that support Voyetra's digital audio data 
sharing protocol, such as WinDAT and AudioView.

Setup Menu

AutoRecord
When Auto Record is checked, Say It will start recording from the moment you activate it. 

When unchecked, Say It waits until you press the Record button, then the Play or Pause button.

Hot Key...
Brings up a dialog box that you can use to set Say It's hot key combination -the combination of 
keystrokes that will activate Say It from within another application.

The Hot Key combination always includes the [Control] key, and a letter or numeral key. You may add 
[Alt], [Shift], both, or neither by turning the check boxes on or off. This is useful if another application 
uses the same Hot Key as Say It.



To change the Hot Key:
1.
2. From the Setup Menu, select 'Hot Key.' A dialog box will appear.

3.
4. Click on the check boxes to turn 'Alt' or 'Shift' on or off as desired.
5.
6. If you wish to change the letter, drag your cursor across the character in the 'Key' box to select it. 

Type a single letter or numeral of your choice. You can not use punctuation or other special 
characters.

7.
8. Click OK.

Maximum Length...
Initially, Say It limits voice notes to one minute in length. You can set this length to any value between 
one second and two minutes.

To adjust the maximum length of voice notes:
1.
2. From the Setup menu, choose Maximum Length....The Maximum Length dialog box will appear.

3.
4. In the Minutes:Seconds box, click on the arrows or drag up or down to adjust the time as desired.
5.
6. When you've finished, choose OK.

Always on Top
When Always on Top is enabled, the Say It window or icon will always appear on top of any other 
applications that are running.

Record µLaw
When enabled, Say It will record voice notes using the µLaw data compression scheme.

Record ALaw
When enabled, Say It will record voice notes using the ALaw data compression scheme.

Help Menu

Activates Say It's on-line Help.



Chapter 5
The Voyetra Jukebox for Windows

Introduction

The Voyetra Jukebox for Windows lets you assemble sound events into a playlist, then play them in 
the order you've arranged. The playlist can include .WAV files, MIDI files, or CD tracks. Jukebox's 
features include:

· Extensive capabilities for creating and editing playlists with standard Windows commands like Cut, 
Copy and Paste.

· The ability to save playlists as files.
· Jukebox's Event Manager gives you a convenient way to search for and audition MIDI and WAV 

files, and to audition CD tracks.
· Uses the Windows Media Control Interface (MCI) for true device-independence.
· CD track names, and disk titles are compatible with the Audiostation CD Module, the Voyetra CD 

Player and Microsoft Musicbox.



Screen Layout

The Windows Jukebox consists of two separate windows: the Playlist window and the Sound Event 
Manager window.

The Playlist Window

This is the window you'll use most frequently. It is divided into the following sections:

· Menu Bar - Contains pull-down menus common to most Windows applications (File, Edit, and 
Options).

· Edit Buttons - Provide quick access to the four most frequently used Edit commands: Cut, Copy, 
Paste, and Undo.

· Transport Buttons - Tape deck style buttons (Play, Stop, Pause, Previous Event and Next Event)
control playback of the playlist.

· Playlist Title Box - Displays the title of the current playlist.
· CD Title Box - Displays the title of the CD in use by the current playlist.
· The Playlist - Displays a list of the individual sound events in the playlist.
· Status Area - Displays the current status of the Playlist (Playing CD, Playing WAV, Stopped, 

Paused, etc.). Also displays how many events are in the playlist, by type.



The Sound Event Manager Window

Use this window to locate, audition and select sound events to add to your playlist. Click on the 
Playlist window's Add... button to gain access to the Sound Event Manager window.

The Sound Event Manager contains four View: buttons that let you choose the type of sound events 
that will be displayed:

· CD - Displays all the tracks available on the CD currently loaded in your CD-ROM drive.
· WAV - Displays all files in the current directory with a .WAV extension.
· MID - Displays all files in the current directory with a .MID extension.
· ALL - Displays all files in the current directory, regardless of the extension.

The WAV, MID, or ALL Buttons

If you click on the WAV, MID, or ALL buttons the Sound Event Manager window will display two list 
boxes:

· A Directory list box on the left displays the available drives and directories
· A File list box on the right displays files of the type chosen with one of the View: buttons



The two text boxes at the bottom of the window display the path and the name of the file that is 
currently highlighted.

The CD Button

If you click on the CD button, the Sound Event Manager will contain a single list box that displays the 
tracks on the current CD.

At the bottom of the window, there are two text boxes that you can use to display the disk title and the 
name of the track that is currently highlighted. Initially, these boxes are blank, as shown above. Later 
in this manual, we'll show you how you can use Jukebox to catalog your CD's by entering disk titles 
and track names.



Verifying and Testing Your System's MCI Configuration

The Windows Jukebox uses a feature of Windows called the Media Control Interface (MCI) that allows
it to work with any Windows-compatible sound hardware.

The Windows Jukebox supports three types of sound events: WAV files, MIDI files, and CD tracks.

For the Jukebox to function, the necessary MCI drivers must be installed and properly configured for 
your system. The MCI drivers should have been automatically installed and configured when you 
installed Windows on your system. However, it's possible that you have modified or deleted the MCI 
driver setup since installing Windows.

To verify that all three MCI drivers are installed:
1.
2. From the Windows Control Panel, double click the Drivers icon. 

3.
4. The list of installed drivers should contain the two following entries:

[MCI] MIDI Sequencer

[MCI] Sound

If you have a CD-ROM drive, the list of installed drivers should also contain the entry:

[MCI] CD Audio
3.
4. If one or more of these entries is missing, refer to the Windows User's Guide to find out how to add

it to your list of installed drivers.

Once you've verified that the necessary drivers are installed, it's a good idea to test your system's MCI
configuration for sound before running the Windows Jukebox. The easiest way to do this is with the 
Windows Media Player accessory.

To test your MCI sound configuration:

Run the Media Player and verify that you are able to play a WAV file, a MIDI file and a CD track with 
its Sound, MIDI Sequencer and CD Audio devices, respectively.

If you're not sure how to use the Media Player, refer to the Windows User's Guide



Windows Jukebox Tutorial

This tutorial on the Windows Jukebox will familiarize you with most of the program's features.

To run the Windows Jukebox:

Double click on its icon.

Playing the Sample Playlist

Playlists are the key to the Jukebox program. You can create as many playlists as you wish, and save 
each one as a file, with a .JUK extension. When you open a Jukebox file and click on the Play button, 
the playlist will find and play each file or CD track in turn. (Of course, the files must be on your hard 
drive in the paths called for, and you must have the correct disk in your CD-ROM drive.) 

We'll show you how to create your own playlists a bit later, but to get you started, we've included a 
sample playlist file called SAMPLE.JUK. 

Though the contents of the sample file illustrated here may not exactly match the one in your software 
package, it will show you how a playlist works. SAMPLE.JUK will play several of the included WAV 
and MIDI files, one after the other.

This sample playlist does not include any CD-ROM tracks.

If, while playing SAMPLE.JUK, you encounter any error messages, refer to the earlier section 
'Verifying and Testing Your System's MCI Configuration'.



To play the sample playlist:
1.
2. Choose Open from the File menu. From the Open dialog box, navigate to the \MEDIAXTC\

WINAPPS directory and open the file called SAMPLE.JUK.
After the file is loaded, the sample playlist will be displayed.

3.
4. Click on the Play button to start the playlist at the beginning.

If no event or the first event in the playlist is currently highlighted, playback will start at the 
beginning of the list.

5.
6. Click on the Stop button to halt playback.
7.
8. To start playing at a specific event in the playlist, highlight the desired event and then click on the 

Play button.
For example, if you highlight the third event and click on the Play button, Jukebox will start 
playing the third event and continue playing to the end of the list.

9.
10.Try using the Previous Event and Next Event buttons to jump backward or forward through the 

playlist, even as the Jukebox is playing.
11.
12.Next, click the Pause button to momentarily pause playback. Click on the Pause button again to 

resume.
The Pause button works just like that on a tape deck. A CD track, MIDI file or WAV file resumes
playback from the point where is it was paused.

13.
14.When you've finished experimenting with the SAMPLE.JUK playlist, click on the Stop button to halt 

playback.
You cannot edit the current playlist or load a different one until you stop playback. These menu 
items will be grayed-out while the Jukebox is playing.

Running the Windows Jukebox in the Background

The Windows Jukebox will always stop executing the playlist when you quit the program. However, 
you can minimize the Jukebox and it will continue to play sound events in the background while you 
work in another Windows application. This feature allows you to listen to, say, a list of MIDI files while 
working on a letter in your Windows word processor.

To execute the playlist 'in the background':

From the Jukebox, load a playlist and start it playing by clicking the Play button.
1.



2. After the playlist starts, minimize the Jukebox windows by clicking on the Minimize button at the 
right end of the Title Bar.

3.
4. You can now switch to any other Windows application.
5.
6. The playlist will continue to play until one of these things occurs:

· It reaches the end
· You halt playback by returning to the Jukebox and clicking the Stop button
· You quit Jukebox or Windows

The Loop Option

Use the Loop option when you want to play a song or group of songs repeatedly If Loop is active, 
when the playlist reaches its end it returns (loops) to the beginning and starts to play again. The 
process will repeat indefinitely, until you stop it.

Choose Loop from the Options menu to activate this feature.

The program always starts with Loop OFF; you must activate it manually.

Editing the Sample Playlist

Now that you're familiar with how to control playback, we're going to edit the sample playlist.

The Windows Jukebox editing procedures (Cut, Copy, Paste, and Undo) will be familiar to anyone 
who's used a Windows-based word processor.

The Cut and Copy Commands

To begin, let's Cut some events and Paste them to a different part of the playlist.

To Cut a single event from the playlist:
1.
2. Click on the event you wish to Cut. The event will be highlighted.
3.
4. Click on the Cut button or choose Cut from the Edit menu.

The highlighted event will be removed from the playlist.
As with all Windows programs, both the Cut and Copy commands place the selected data in the 
Clipboard. The difference is that Cut removes the selected data; Copy does not.

You can also use the mouse to Cut or Copy a group of several consecutive or non-consecutive 
events.

To Cut or Copy a series of consecutive events:
1.
2. Highlight the first event, click the mouse button and drag the mouse up or down.
3.
4. Click on the Cut or Copy button.

Or, choose Cut or Copy from the Edit menu.

To Cut or Copy a group of non-consecutive events:
1.
2. Hold down the [Ctrl] key and click on each of the events that you wish to Cut or Copy

To de-select any event click on it again while holding down the [Ctrl] key.
3.
4. Click on the Cut or Copy button.

Or, choose Cut or Copy from the Edit menu.



The Paste Command

Now we're going to Paste the events that we just cut to a different part of the same playlist.

As with a word processor, you highlight a specific line of text to determine where the data will be 
Pasted. The program uses the following rules for determining where to insert event(s):
·
· If no event in the playlist is currently highlighted, any Pasted events will be added to the end of the 

playlist.
·
· If one or more events in the playlist are currently highlighted, any Pasted events will be inserted 

before the first highlighted event.
·
· If you want to Paste events to the end of the playlist while any events are currently highlighted, you

must de-select the highlighted events first. Click on the Edit menu and select Deselect All before 
Pasting.

To Paste to the end of the playlist:
1.
2. If any events in the playlist are highlighted, choose Deselect All from the Edit menu.
3.
4. Click on the Paste button or choose Paste from the Edit menu.

The events that you cut or copied will be added to the end of the playlist.

To Paste within the playlist:
1.
2. Highlight the line just below the point where you wish to Paste the event.
3.
4. Click on the Paste button or choose Paste from the Edit menu.

The event or group of events will be inserted above the highlighted line and any subsequent events
will move down to accommodate them.

The Undo and Delete Commands

The Windows Jukebox includes several more commands for editing playlists:
· As with most Windows programs, the Undo menu command lets you undo your most recent editing

operation.
· The Undo Button provides a quicker way to use the undo command
· A series of Delete All commands provide an easy way to delete all events of a specified type from 

your playlist.



The Sound Event Manager

You now know how to delete and move events within an existing playlist. Now let's look at how to add 
new events and how to build a playlist from scratch. A second window called the Sound Event 
Manager helps you with these tasks.

Locating Sound Events

The Sound Event Manager can help you locate and audition WAV and MIDI files or CD tracks and add
them to a playlist.

Since only one CD can be in your CD-ROM drive at a time, all CD tracks in a playlist must be from the
same CD.

To locate and audition sound events:
1.
2. Click on the Add... button to access the Jukebox Sound Event Manager.
3.
4. Choose the type of sound event you wish to see by clicking on the appropriate View: button.

If you chose WAV or MIDI files, use the Directory list box to navigate to the drive and directory 
where the files are located. If you're not sure how to use a Windows directory list box to move 
between directories, refer to the Windows User's Guide.

5.
6. To audition a file or CD track, highlight it and click on the Event Manager's Play button.

Using the Auto Audition Option

When Auto Audition is active, you can audition sound events by simply clicking on them in the Sound 
Event Manager; you don't need to click on the Play button. The program always starts with Auto 
Audition OFF; you must activate it manually .

Choose Auto Audition from the Options menu to activate Auto Audition.



Adding New Events to the Playlist

You can use the Sound Event Manager to add new events to an existing playlist or to create a new 
one. When you add new events, the program follows the same rules as for normal Paste operations:

· If no event in the playlist is currently highlighted, any Pasted events will be added to the end of the 
playlist.

· If one or more events in the playlist are currently highlighted, any Pasted events will be inserted 
before the highlighted events.

· If you want to Paste events to the end of the playlist while any events are currently highlighted, you
must de-select the highlighted events first. Click on the Edit menu and select Deselect All before 
Pasting.

For this tutorial, we're going to create an entirely new playlist. However, you can use the same 
methods to add new events to an existing playlist.

Let's start by adding the first event to our playlist. Since this is the first event, it won't matter what 
region of the playlist is highlighted.

To add a single event to the playlist, you simply double-click on the desired event in the Sound Event 
Manager.

To add single events to the playlist (using the double-click method):
1.
2. Choose New from the File menu to load a new, blank playlist file.
3.
4. If you have a CD-ROM drive and you want to include CD tracks in your playlist, insert an audio CD 

into the drive.
Unless you explicitly name CD tracks, they will be listed generically as 'Track 1', 'Track 2', and 
so on. For more information, refer to 'Working With CD Tracks' on page 19. 

5.
6. Click on the Add... button. The Jukebox Sound Event Manager will appear.
7.
8. Click on the appropriate View: button to choose the type of sound event you wish to display. If you 

chose WAV or MID, navigate to the desired drive and directory.
9.
10.From the Sound Event Manager, double-click on the event you wish to add to the playlist.

That event will now be displayed as the only event in the playlist.
11.
12.Double-click on additional events in the Sound Manager, one at a time, to add them your playlist.

Now let's add a group of new events to your playlist. You do this with the Copy and Paste commands, 
just as you do from the Playlist window. As with the Playlist window, the Sound Event Manager lets 
you select a group of consecutive or non-consecutive events.

When copying events from the Sound Event Manager, you must use the Copy command; you cannot 
use the Cut command.



To Copy consecutive events from the Sound Event Manager:
1.
2. From the Sound Event Manager, click and drag the mouse to highlight the desired events.
3.
4. Click on the Copy button in the Playlist window.

Or, choose Copy from the Edit menu.

To Copy a group of non-consecutive events from the Sound Event Manager:
1.
2. From the Sound Event Manager, hold down the [Ctrl] key and click on each of the events you wish 

to copy. 
To de-select any event, click on it again while holding down the [Ctrl] key.

3.
4. Click on the Copy button in the Playlist window.

Or, choose Copy from the Edit menu.

To Paste a group of new events within the playlist:
1.
2. Copy the desired events from the Sound Event manager using the methods described above.
3.
4. Highlight the line in the playlist just below the point at which you want to insert the new events.
5.
6. Click on the Paste button or choose Paste from the Edit menu.

The group of events will be inserted above the highlighted line, and the subsequent events will be 
shifted downward to accommodate them.

To Paste to the end of the playlist:
1.
2. If any events in the playlist are highlighted, de-select them by choosing Deselect All from the Edit 

menu.
3.
4. Click on the Paste button or choose Paste from the Edit menu.



The events will be inserted at the end of the playlist.

Once you're satisfied with your new playlist, you can save it as a playlist file. The Windows Jukebox 
saves playlist files with a .JUK extension.

To Save the new playlist:
1.
2. If necessary, halt playback by clicking on the Stop button.
3.
4. Before saving the playlist, you can give it a title by entering the desired name in the Playlist Title 

Box.
5.
6. Choose Save from the File menu.

If you're saving a new file, the Save As dialog box will appear and you will be prompted to type in a file
name.



Working With CD Tracks

When you place a disk in your CD-ROM drive, open the Sound Event Manager and select 'CD', the 
Windows Jukebox initially displays [Untitled] as the disk's title and a generic title - Track 1, Track 2, 
and so on - for each of its tracks.

With the Jukebox program you can enter the correct titles (or any other text that you wish) in place of 
these generic titles before you copy them to the playlist.

The titles you enter will be incorporated into the playlist when you save it. If you don't take this step, 
only the generic titles will appear in your playlist, and you may have difficulty remembering the 
contents of a playlist later.

For our example we have created an imaginary CD-'Great Symphonies'.

Entering Disk Titles and Track Names

Disk Title

To enter a disk title:
1.
2. Load a CD into your CD-ROM drive.
3.
4. Click on the Add... button to enter the Sound Event Manager, then select 'CD.'
5.
6. Place the cursor in the CD Title box and enter the desired title. In most cases, you will probably 

want to enter actual title of the CD, but you can enter any text you wish. In this example, we've 
typed, 'Great Symphonies'.

When you add any track from the CD to a playlist, the CD title you entered will be placed in the 
Playlist window's CD Title box.

When you save the playlist, the contents of the Playlist window's CD Title box will be saved along with 
the rest of the information.

Track Names

If you want track titles to appear in a Playlist, you must enter them in the Sound Event Manager before
placing tracks in the playlist. You cannot edit the track names in a playlist.

To enter a track name:
1.
2. If you haven't already done so, load a CD according to steps 1 and 2 above.
3.
4. Highlight the track you wish to name.
5.
6. Enter the desired name into the Sound Event Manager's Track Title text box at the bottom of the 

window(You can temporarily remove the CD from the drive to look at the track titles, if you wish.
Be sure to replace it before continuing.)
As you type in the track name, the name listed in the Sound Event Manager will be 
simultaneously updated.

7.
8. When you add the track to your playlist, it will be listed with the new name.



9. Once you've created a track list, you can copy titles from the CD track list into any Playlist, just as 
you would a .WAV or .MID file.

Since only one CD can be in your CD-ROM drive at a time, all CD tracks in a given playlist must be 
from the same CD.

6.
7. Save your playlist.

Because the CD track titles you enter in the Sound Event Manager cannot be saved, we recommend 
that you create and save a complete reference playlist for each CD before you begin copying track 
titles to other playlists.

Using Jukebox with Other CD-ROM Software

CD track names and disk titles entered in Jukebox are readable by the Audiostation CD Module, the 
Voyetra CD Player, and Microsoft's Musicbox. Likewise, Jukebox will read disk titles and track lists 
created by any of these other programs.

When you save a track list with the Audiostation CD Module, the Voyetra CD Player or Microsoft 
Musicbox, the disk's title and its track names are saved in a file called MUSICBOX.INI. Whenever the 
Windows Jukebox scans a disk, it checks to see if a MUSICBOX.INI track list exists for that CD. If a 
MUSICBOX.INI track list for that CD is found, the disk title and track names it contains will 
automatically be displayed by the Jukebox Sound Event Manager.



Chapter 6
The DOS Mixer Utility
Introduction

The DOS Mixer Utility that lets you control the various mixer functions supported by the SPEA MEDIA 
XTC. It is compatible with many DOS-based programs that utilize the card's sound capabilities.

The DOS Mixer utility can function as either a terminate-and-stay-resident (TSR) program or as a 
conventional program.

Compatibility

The DOS Mixer will work in conjunction with most DOS sound applications that use Voyetra's Sound 
Factory drivers for their sound functionality. Such programs include:

· The MIDI and Digital Audio Command Line File Players included in this package (PLAY and 
DAPLAY).

· All DOS applications available from Voyetra Technologies (Sequencer Plus, DOSDAT, 
SoundScript for DOS, etc.).

· Non-graphics third-party multimedia and music applications that support the Voyetra Sound 
Factory drivers.

· Other DOS applications that do not take control of the SPEA MEDIA XTC's mixer functions.

The DOS Mixer will not work with:
· DOS applications that use a graphics (non-text) display mode.
· Applications that take control of the SPEA MEDIA XTC's mixer functions.

Loading the DOS Mixer as a TSR

The DOS Mixer is automatically loaded into memory as a TSR whenever you run the DRIVER.BAT 
file.

When used as a TSR, the DOS Mixer is loaded into memory and can then be 'popped-up' at any time 
with a simple hot key combination, [Alt]-M. You can even pop-up the Mixer from within another DOS 
text-mode program, such as DOSDAT.

After it's initially loaded, the DOS Mixer can be quickly called up whenever you need to adjust the 
settings by simply typing [Alt]-M. In most cases, this is probably the most useful and convenient way 
to use the program. Probably the only time you would not want to use the DOS Mixer as a TSR would 
be in the event that you needed as much free memory as possible to run another application (as 
indicated by 'Not Enough Memory' or some other error message).



To load the DOS Mixer Utility as a TSR:
1.
2. From the \VOYETRA directory, load the TAPISNDS driver and the DOS Mixer by typing:

DRIVER [Enter]
2.
3. You will then be presented with some text indicating that the DOS Mixer has been loaded, as well 

as some instructions on how to use the program. 
4.
5. You can now activate ('pop-up') the DOS Mixer at any time by typing:

[Alt]-M
6.
7. Once the DOS Mixer is activated, the following panel will appear:

8.
9. You can now make any necessary adjustments to the mixer settings. If you have popped-up the 

DOS Mixer from within another program (like DOSDAT or Sp Jr), you can even adjust the mixer
settings on-the-fly while the other program is playing sound.

10.
11.After you've made the necessary adjustments, you can clear the mixer panel from your screen by 

pressing the [Esc] key.
The mixer adjustments you've made will be maintained until you modify them with the DOS Mixer 
or some other program. 

In the unlikely event that you need to free-up memory to run some other application, you can remove 
the DOS Mixer from memory at any time.

To remove the DOS Mixer from memory:
1.
2. From the \VOYETRA directory, type:

DMIX /rem [Enter]



Running in Non-TSR Mode

In some cases, you may want to run the DOS Mixer as a non memory-resident program from the DOS
command line. This can be done by running the program with the /nmr (non memory-resident) option. 
Obviously, this mode does not allow you to access the DOS Mixer from within another program. 

When run in this mode, the DOS Mixer's panel will immediately come up on the screen and you can 
make any necessary adjustments to the mixer settings. You can then quit the DOS Mixer just like you 
would any other program, without any of the program remaining loaded in memory. 

To run the DOS Mixer Utility as a non-TSR:
1.
2. Using a text editor, edit the DRIVER.BAT file and add the /nmr option to the DMIX line so that it 

reads:

DMIX /nmr
3.
4. From the \VOYETRA directory, load the drivers and DOS Mixer by typing:

DRIVER [Enter]

The DOS Mixer's panel will immediately appear on your screen. You can now make any 
necessary adjustments to the mixer settings. 

5.
6. After you've made the necessary adjustments, you can quit the DOS Mixer by pressing the [Esc] 

key.

The mixer adjustments you've made will be maintained until you modify them with the DOS Mixer or 
some other program.



The Mixer Controls

Mixer Panel Layout

All of the DOS Mixer's numerical controls can be adjusted between 0 and 99.

Many of the DOS Mixer's controls are 'stereo'; they offer independent adjustment of the left and right 
channels. 

To move the cursor between the different controls:

Press the [Up] or [Down] arrow keys.

Or

Press the [Tab] key to move down; press [Shift][Tab] to move up.

To adjust the numerical controls:
1.
2. Move the cursor to the desired control.
3.
4. Press the + or - keys to increment or decrement the value by 1; press the [ or ] keys to increment 

or decrement the value by 10.

Or

Type in the desired value and press [Enter].

The mixer's front panel is divided into four different sections. From top to bottom, these are: 

The Master Controls

This section contains the control for Master volume, Bass, and Treble.
· Master : Controls the SPEA MEDIA XTC's overall playback level.
· Bass: Controls the SPEA MEDIA XTC's overall bass level.
· Treble: Controls the SPEA MEDIA XTC's overall treble level.



Playback Controls

The Playback section contains the controls that let you adjust the output (playback) levels of each of 
the SPEA MEDIA XTC's individual sound sources. 

· Synth: Controls the playback level of the SPEA MEDIA XTC's on-board wavetable synthesizer.
· Wav: Controls the playback level of the SPEA MEDIA XTC's digital audio hardware.
· Line: Controls the playback level of a line-level audio source connected to the SPEA MEDIA XTC's

Line In jack, or the level of the CD-ROM drive's audio (assuming that the CD-ROM drive's audio
output is connected to either the Line In jack or the multi-pin header located on the SPEA 
MEDIA XTC's PC board). 

· Mic: Controls the playback level of a microphone connected to the SPEA MEDIA XTC's Mic jack. 

Record Controls

The Record section contains two controls that let you determine whether the Line or Mic input is 
recorded and adjust its input level. 

· Line: Controls the record level of a line-level audio source connected to the SPEA MEDIA XTC's 
Line In jack, or the CD-ROM drive (assuming that the CD-ROM drive's audio output is 
connected to either the Line In jack or the multi-pin header located on the SPEA MEDIA XTC's 
PC board). 

· Mic: Controls the record level of a microphone connected to the SPEA MEDIA XTC's Mic jack. 

Since the SPEA MEDIA XTC can only record from one input at a time (either Line or Mic), the Record 
section's Line and Mic controls are mutually-exclusive. That is, when you adjust one input to a non-
zero value, the other input is automatically disabled.

Mode and Lock Controls

The bottom section contains the Stereo and Lock controls.

Stereo

The Mode control lets you choose one of three different stereo modes for the SPEA MEDIA XTC's 
audio output: Linear, Pseudo, or Spatial.

This feature allows you to create different spatial effects, or to optimize the SPEA MEDIA XTC's 
sound for specific applications, listening environments, or program material. The effect of the different 
modes is described in detail in the Audiostation chapter.

To change the Mode:
1.
2. Move the cursor to the Stereo control.
3.
4. Press the + or- keys, the [ or ] keys, or the [Spacebar].

Lock

The Lock control can be toggled either On or Off. When Lock is On, all of the stereo controls' left and 
right channels will be 'locked' together. In other words, you can adjust both the left and right channels 
of a control by simply adjusting one channel. 



To turn Lock On or Off:
1.
2. Move the cursor to the Lock control.
3.
4. Press the + or- keys, the [ or ] keys, or the [Spacebar].



Appendix
Supplementary Information

This section contains additional information about using the Voyetra Multimedia Sound Software and 
the SPEA MEDIA XTC.

Re-installing the Software

If you accidentally remove any of the programs or their Windows program items, the Windows drivers, 
the default MIDI maps, etc., it's probably a good idea to simply run the installation again. 

Changing the Hardware Settings

If you change any of the SPEA MEDIA XTC's hardware settings (IRQ, I/O address, DMA), you must 
re-configure both the DOS and the Windows drivers accordingly. 

Although you can re-configure the Windows drivers from the Control Panel's Driver applet, the DOS 
drivers are not quite so easy to re-configure. Therefore, it's probably a good idea to run the installation
again. During the installation, make sure to enter the SPEA MEDIA XTC's new hardware settings 
correctly.

About the MIDI Mapper

During the installation, you will be given the option of installing MIDI maps designed specifically for the
SPEA MEDIA XTC. If you choose Yes, your current MIDI map configuration will be backed-up as 
MIDIMAP.BAK and replaced with two custom Windows MIDI maps for the SPEA MEDIA XTC.

About the MIDI Mapper

During the installation, you will be given the option of installing a MIDI map designed specifically for 
the SPEA MEDIA XTC. If you choose Yes, your current MIDI map configuration will be backed-up as 
MIDIMAP.BAK and replaced with a default MIDI map for the SPEA MEDIA XTC's FM synth.

This is the MIDI map you'll want to use in most cases, unless you've installed the optional MIDI 
connector and want to use external MIDI instruments.

For more information on using the MIDI Mapper, refer to the Windows Users Guide.



SPEA MEDIA XTC Synth (default)

This is the MIDI map you'll want to use in most cases. It will route MIDI data on channels 1-10 to the 
SPEA MEDIA XTC's high-quality wavetable synthesizer.

SPEA MEDIA XTC MPort

This MIDI map will route MIDI data on channels 1-10 to the SPEA MEDIA XTC's optional MIDI 
connector. Use this map if you want to play back through external General MIDI devices instead of the
on-board wavetable synth.

In some situations (combining the SPEA MEDIA XTC's synth with other MIDI devices, using external 
non-General MIDI devices, etc.) you will need to modify one of the default MIDI maps or create a new 
one from scratch. For information on these procedures, refer to the Microsoft Windows Users Guide.

Compression Support 

In addition to 8- and 16-bit PCM, the drivers for the SPEA MEDIA XTC and the applications in this 
package also support the ability to play back and/or record .WAV files using the ALaw and mLaw data 
compression schemes. 

This feature allows you to use the SPEA MEDIA XTC in applications where smaller .WAV file size is 
desirable or necessary. 

Voyetra's Sound Factory Drivers for DOS

The DOS applications in this package get their sound functionality from Voyetra's popular Sound 
Factory drivers. These drivers also allow you to use the SPEA MEDIA XTC with Voyetra's entire line 
of DOS-based software products, plus many third-party DOS multimedia applications, including: 
WordPerfect 6.0, WordPerfect Presentations, WordPerfect Office, Software Publishing's Harvard 
Graphics for DOS, Mathematica's Tempra Show and Media Author, and Vision Imaging's Media 
Master and Multimedia Studio, and many others.

The Sound Factory drivers are Terminate and Stay Resident (TSR) Applications Program Interfaces 
(API) that are structured on two levels:

VMP

A high-level record/playback API called the Voyetra Multimedia Player (VMP) provides a small set of 
function calls for real-time control of CD audio, digital audio, MIDI and timer services. Because it is 
fully preemptive, control is returned to the application once the playback or record process is 
activated. VMP plays MIDI files that adhere to the Standard MIDI File Format, which may be created 
and edited using a MIDI sequencing program.



Low-Level API's

A set of low-level APIs that offer detailed control over the PC sound hardware. The low-level APIs 
(VAPI for MIDI, SAPI for synthesis and AAPI for digital audio) provide device independence and a rich
set of function calls for directly controlling PC sound hardware. For multi-function sound cards, there is
also a combined low-level API called TAPI that includes the MIDI, synthesis, and digital audio 
functions. 

The API level accessed by the program depends upon the application. For instance, a multimedia 
presentation program would use VMP for adding music and voice narrations to PC screen images, 
while an editing tool such as Voyetra's Sequencer Plus uses the low-level APIs for finer control over 
the MIDI and synthesis hardware. Because they are TSR's, the Sound Factory APIs may be moved 
into extended memory using DOS 5 on a 386 PC or using memory manager programs such as QEMM
or QRAM.

Using VMP and the low-level API's, DOS software developers can easily add sound to existing 
applications while supporting a wide range of sound hardware. For information on Voyetra's Sound 
Factory Programmer's Toolkit, please contact:

Voyetra Technologies, 5 Odell Plaza, Yonkers, NY 10701-1406, U.S.A.
Telephone: (914) 966-0600
Fax: (914) 966-1102



Voyetra Software Upgrades

The Multlmedia Sound Software in this package was created by Voyetra Technologies, a leader in the 
evolution of electronic music and PC sound technology since 1975. Voyetra provides MIDI, Digital 
Audio and CD-ROM software to the 'Who's Who' of the computer sound industry. Special 
arrangements with the manufacturer of your SPEA MEDIA XTC entitle you to purchase these 
enhanced versions of Voyetra Multimedia Sound Software at special low prices.



In addition to the special offers listed here, Voyetra offers a full line of software and hardware products
that can turn your PC into a complete sound workstation.

For more information, or to order Voyetra Software products call:

1-800-233-9377

FAX: (914) 966-1102 From outside USA: (914) 966-0600 



Voyetra End-User Software License Agreement

Carefully read the following Agreement before opening the diskette envelopes and installing this 
software.

By installing this software you acknowledge that you have read, understood and agree to abide by the 
terms and conditions of this Agreement. If you do not agree with the terms of this Agreement, 
promptly contact the seller of this software to arrange an appropriate remedy.

SOFTWARE LICENSE: This is a legal agreement (Agreement) between you (either an individual or an
entity) and Voyetra Technologies (Voyetra) that sets forth the license terms and conditions for using 
the enclosed Software (Software) and updates of the Software. In this Agreement, the term 'use' 
means loading the Software into RAM, as well as installing it onto a hard disk or other storage device.

The Software is owned by Voyetra and is protected under United States copyright laws as well as 
international treaty provisions. You must treat the software as you would any other copyrighted 
material. Voyetra retains title and ownership of the Software. The purchase price for the Software 
grants you a non-exclusive license to use one copy of the Software on a single computer. You may 
make copies of the software solely for archival purposes. You may not make copies of any written 
material accompanying the software. If the package contains 3.5" and 5.25" disks, then you may use 
only the disks appropriate for your single designated computer. You may not use the other disks on 
another computer or loan, rent, lease or transfer them to another user. You may not allow third parties 
to use the Software by time-sharing, networking or any other form of multi-user participation. You may 
not rent, sell, lease, sub-license, time-share or lend the Software to a third party or otherwise transfer 
this License without written permission from Voyetra. You may not decompile, disassemble, reverse-
engineer or modify the Software. 

This Agreement is effective until terminated by the destruction of the Software and all of the diskettes 
and documentation provided in this package, together with all copies, tangible or intangible. If you fail 
to comply with any of the terms and conditions of this Agreement, this License will be terminated and 
you will be required to immediately return to Voyetra, the Software, diskettes and documentation 
provided in this package, together with all back-up copies. The provisions of this Agreement which 
protect the proprietary rights of Voyetra will continue in force after termination.

LIMITED LIABILITY: You assume responsibility for the selection of the Software to achieve your 
intended results, and for the installation, use and results obtained from the Software. VOYETRA 
MAKES NO REPRESENTATIONS OR WARRANTIES WITH REGARD TO THE SOFTWARE AND 
DOCUMENTATION, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Voyetra shall not be liable for 
errors or omissions contained in software or manuals, any interruption of service, loss of business or 
anticipatory profits and/or for incidental or consequential damages in connection with the furnishing, 
performance or use of these materials. The Software and Documentation are sold AS IS.

This Limited Warranty gives you specific legal rights and you may also have other rights which vary 
from state to state. Some states do not allow the limitation or exclusion of implied warranties or of 
consequential damages, so the above limitations or exclusions may not apply to you. You agree that 
this is the complete and exclusive statement of the Agreement between you and Voyetra which 
supersedes any proposal or prior agreement, oral or written, and any other communications between 
us regarding the subject matter of this Agreement. This Agreement shall be construed, interpreted and
governed by the laws of the State of New York, except the federal laws which govern copyrights and 
registered trademarks. If any provision of this Agreement is found unenforceable, it will not effect the 
validity of the balance of this Agreement, which shall remain valid and enforceable according to its 
terms.
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